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1 Introduction 

This manual covers the functionality of the TEC-Family digital temperature controllers. If you use our 

TEC Controllers the first time, we recommend you watch first our tutorial videos or read the step-by-

step guide document available on our website.  

Most of the explanations in this document assume, that you use the "TEC Configuration Software", but 

all the operations can also be done by your own application if you implement the functionality. Most 

of the commands are documented in our communication protocol documents. 

If you cannot find the feature or setting you need, please do not hesitate to contact our support. We 

do also provide customized firmware solutions. 

1.1 Important Documents 

• Datasheets 

o Technical specifications 

o Temperature configurations and possible temperature measurement ranges 

o Ordering information 

• TEC-Family Communications Protocol 

o Protocol specification 

o Commands, Parameters 

o Example Application and APIs 

• Temperature Sensor Cable Specifications 

o Pinout 

o Temperature sensor assembly 

• Temperature Sensor Suggestions 

o Description, part numbers and distributors for NTC, PT100 and PT1000 sensors 

• Tutorial Videos 

o Learn more about the TEC Controller features and how to set up a cooling system 

• Application Notes 

o Additional Information about different usages of our TEC Controllers 

1.2 How to Contact Support 

For optimal technical assistance we need the following information: 

• Configuration file (if possible exported while the error is present) 

o Click on the "File → Export Config" option in the menu bar of the main window of the 

Configuration Software. 

• Monitor History 

o In the "Log" window, which you can access by clicking on the "Log" button or by click-

ing on the "Tools → Log" option in the menu bar in the main window, click on the 

"Export to Excel" button. 

Start the TeamViewer software from our website for a remote-control session. As soon as you start 

the tool, we will recognize you, but please make sure to call or write us beforehand. 

  

https://www.meerstetter.ch/
https://www.meerstetter.ch/customer-center/downloads/category/29-latest-datasheets
https://www.meerstetter.ch/customer-center/downloads/category/35-latest-communication-protocols
https://www.meerstetter.ch/customer-center/downloads/category/31-latest-software
https://www.meerstetter.ch/customer-center/downloads/category/46-cables
https://www.meerstetter.ch/customer-center/downloads/category/46-cables
https://www.meerstetter.ch/customer-center/downloads/category/45-temperature-sensors
https://www.meerstetter.ch/customer-center/downloads/category/45-temperature-sensors
https://www.meerstetter.ch/customer-center/videos
https://www.meerstetter.ch/customer-center/videos
https://www.meerstetter.ch/customer-center/downloads/category/63-application-notes
https://www.meerstetter.ch/customer-center/downloads/category/63-application-notes
https://www.meerstetter.ch/customer-center/support
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1.3 Software Requirements 

The TEC Configuration Software is built on top of .NET 8 by Microsoft. Unlike the older .NET Frame-

work, that the previous TEC Service Software was based on, this runtime is not installed by the Win-

dows operating system by default. Therefore, to be able to run the TEC Configuration Software it is 

necessary to first download and install the .NET 8 Desktop Runtime. This runtime can be download 

from the following page on the official Microsoft website: Download .NET 8.0 (microsoft.com). Alter-

natively, the TEC Configuration Software will display a corresponding dialog when it is launched with-

out the runtime being installed on the machine. 

https://www.meerstetter.ch/
https://dotnet.microsoft.com/en-us/download/dotnet/8.0
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2 Basic Functions 

2.1 The Status Bar of the TEC Configuration Software 

The bottom row of the software is always visible and shows the following information: 

• Left: Connection status 

• Middle: Device status (clicking on this control element will perform a Reset of the TEC Control-

ler. 

o Ready: Normal standby status (no errors). Output stage disabled. 

o Run: Normal operating status (no errors). Output stage enabled. 

o Error: Error occurred. Output stage disabled. 

o Bootloader: Firmware is being updated. 

• Right: Unsaved parameters status (clicking on this control element will save the unsaved pa-

rameters onto the connected device) 

o Transparent: No unsaved parameters present. 

o Orange: Unsaved parameters present. 

▪ By hovering over this control element in this state, you may see a list of cur-

rently unsaved parameter changes. 

 
Figure 1: Status bar at the bottom of the TEC Configuration Software. 

  

https://www.meerstetter.ch/
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2.1.1 Status LEDs and Configuration Software Status 

TEC-Family devices feature two status LEDs. In normal operation, the green LED is blinking. 

In the case of any error occurring, the TEC Controller enters an error status, and the red LED is lit. 

Power circuitry (output stage) is immediately deactivated for safety reasons. Control, monitoring, and 

communication circuitry remains active. In case of software / configuration errors (i.e., not hardware 

faults), parameter can be reconfigured on the fly. The TEC Controller needs to be software-reset or 

power-cycled to the clear the error status. 

Table 1: Status LED description 

Green LED Red LED Signification 

Blinking slowly - "Ready" status (no errors). TEC output stage disa-
bled. 

Blinking fast - "Run" status (no errors). TEC output stage is ac-
tive. 

- Static on "Error" status. TEC output stage disabled. 

Static on Static on "FW Update" status. 

Blinking Blinking slowly Unreleased/Custom firmware is running on the 
device. 

 

When the TEC Configuration Software is connected to a TEC Controller, the status of the device is 

displayed in the bottom of the software window: 

 

Figure 2: TEC Configuration Software color codes for connection and device status. 

Error Condition: 

If the TEC Controller enters an error condition, please hover over the red status control element that 

shows the "Error" text at the bottom of a window. There you can find the error number and descrip-

tion as well as further steps you can take to mitigate the error or reset the device. 

Alternatively, you can find a list of all errors here: 8.2 Error Numbers, Instances and Parameters. 

2.1.2 Reset the TEC Controller 

Whenever the TEC Controller enters an error state it is necessary to perform a "Reset" action to clear 

the error. This can either be done by power cycling the device or by one of the following options within 

the TEC Configuration Software: 

- Click on the "Device Status" control element in the middle of the Status Bar at the bottom of 

most windows. 

- Use the "Device → Reset" option in the main window. 

  

https://www.meerstetter.ch/
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2.1.3 Temperature Stability Indicator 

For some applications temperature stability within a temperature range or the time for the stability is 

important. 

When a TEC Controller output stage is operated as temperature controller, the background color of 

the temperature value in Figure 1 is a visual indicator for stability: 

• Green, if the temperature is stable 

 
• Amber, if the temperature is not within the defined criteria 

 
• Transparent, if the output stage isn't operated as a temperature controller or if the output 

stage is off 

 

The Temperature Stability Criteria consists of a temperature range and time frame, defined in the 

"Temperature Controller" window within the "Stability Indicator" box. Stability is given if the temper-

ature is… 

• inside the range defined in "Deviation" 

• for a certain time (seconds) defined in "Time". 

An error is thrown if the object temperature is not stable within the time defined in "Max Time". To 

disable this feature, set this parameter to 0. 

  

https://www.meerstetter.ch/
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2.1.4 Writing and Reading Device Parameters 

When a parameter value is changed an orange circle ("Changed Icon") will appear next to it in the 

software. When hovering over this circle it will display what the old value was before the change and 

what the new value will be once written to the device. The old value can be restored before the new 

value is written to the device by clicking on the circle. 

 

Figure 3: Example tooltip that is displayed when hovering over the orange "Changed Icon" next to a parameter that contains 
an unsaved change. 

Changed parameters are saved to the controller by either clicking on the "Unsaved parameters" field 

in the status bar of the software, through the "Device → Write Config" option in the menu bar of the 

main window or by hitting the "Enter" key when the focus is within a parameter control field. 

When hovering over the "Unsaved parameters" field in the status bar of the software the parameters 

that hold unsaved changes are also listed. 

 

Figure 4: Example tooltip that is displayed when hovering over the "Unsaved parameter" field in the status bar. 

Multiple parameter fields can be written at once. Be aware that also fields in windows which are not 

displayed are written to the controller. 

To clear all unsaved parameters without writing them to the device perform a "Reset" or power cycle 

the device. 

Parameters are read automatically when a connection to the controller is established. 

  

https://www.meerstetter.ch/
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2.1.5 Importing and Exporting XML Configuration Files 

TEC Controller device configuration sets can be exported as backup, replication onto other devices or 

for support purposes. They are device-specific as they contain calibration data, but they can still be 

imported onto other devices without issue as device-specific parameters will simply be skipped during 

the import process. 

• Export 

o To save a configuration file on the PC, click on "File → Export XML Config" in the menu 

bar of the main window of the Configuration Software. 

o All actual values are stored. The values are useful for support and analysis. 

• Import 

o To load a configuration file from the PC, click on "File → Import XML Config" in the 

menu bar of the main window of the TEC Configuration Software. 

o Temperature measurement calibration data is only imported when the serial number 

in the configuration file matches serial number of the connected device. 

o To load a configuration file, that was created using the TEC Service Software, which 

used another format (.ini) than the TEC Configuration Software, click on "File → Import 

INI Config". Note: Only the import of configuration files from the TEC Service Software 

is supported. 

 

Figure 5: Import and Export Options in the TEC Configuration Software. 

  

https://www.meerstetter.ch/
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2.2 Tooltips 

The various input control elements of the TEC Configuration Software, e.g., text input fields, 

dropdowns, radio buttons, that are used to display and modify parameter values on a TEC Controller 

provide a variety of information in a tooltip when hovering over them. 

 

Figure 6: Tooltip of the Target Temperature input field (highlighted in yellow). 

The tooltip not only contains the full name and a short description of the parameter, but also "Com-

munication Interface Information", which is supposed to help provide the necessary parameters, when 

it comes to accessing a parameter for example via one of the various API options that are available. 

Keep in mind that some information in the tooltips is only available when the TEC Configuration Soft-

ware is connected to a TEC Controller. 

The tooltips are shown by default, but advanced users that are already familiar with the parameters 

may optionally disable them by unchecking the option "Enable Mouseover Tooltips" in the "Application 

Settings" window. This window is accessible via "View > Application Settings" in the menu bar of the 

main window. 

https://www.meerstetter.ch/
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2.3 Remote Control Options 

This is an overview of the different remote-control options for the TEC Controllers. It is possible to 

configure, control and monitor the TEC Controllers using any software which can communicate over 

an appropriate interface. In the Document "TEC Controller Communication Protocol 5136" a list of the 

software options available from us can be found. 

Generally, all parameters available in the Configuration Software can be read and written by other 

means using the communication protocol. 

More information is available in the following documents: 

• TEC Controller Communication Protocol 5136 

• TEC LabVIEW Control Software Notes 5200 

• MeComAPI Documentation 

 

Figure 7: TEC Controller remote control options. 

2.3.1 Serial Communication 

Serial communication is used to send data from a host to a TEC Controller and receive data from the 

controller, respectively. The following physical interfaces are supported: 

• USB 

• RS485 (Further information: TEC Application Note - RS485 Interface) 

• RS232 TTL1 

Communication using the Configuration Software and RS485 is only possible using a USB–RS485 

adapter or an ethernet serial server, since the Configuration Software only connects to FTDI2 chips or 

TCP port 50000. 

  

 

1 Not available on all TEC Controllers 
2 One option is the USB RS485 converter cable from FTDI Chip, available in different lengths. 

https://www.meerstetter.ch/
https://www.meerstetter.ch/customer-center/downloads/category/35-latest-communication-protocols
https://www.meerstetter.ch/customer-center/downloads/category/35-latest-communication-protocols
https://www.meerstetter.ch/customer-center/downloads/category/31-latest-software
https://www.meerstetter.ch/customer-center/downloads/category/31-latest-software
https://meerstetter.ch/customer-center/downloads/category/63-application-notes
http://www.ftdichip.com/Products/Cables/USBRS485.htm
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2.3.1.1 Addressing Specific TEC Controllers 

Assign a unique "Device Address" to the TEC Controller if multiple TEC Controllers are operated on the 

same platform bus, e.g., when mounted in an LTR-1200 rack enclosure or when the TEC Configuration 

Software should connect to a specific device. The "Device Address" can be set within the "Communi-

cation" window when the TEC Configuration Software is already connected to the device. You can then 

advise the TEC Configuration Software to use a specific device address to communicate with a device. 

For this open the "Connection Criteria Manager" window from the "Tools" menu in the menu bar of 

the main window and look for the "Device Address" input field. For more application arguments, check 

out the Communication Protocol document. 

Note: All TEC Controllers have a 1-unit load receiver input impedance, allowing up to 32 transceivers 

on the bus. 

2.3.2 Ethernet Communication 

Communication over Ethernet is possible by integrating up to four TEC Controllers into a LTR-1200 19-

inch rack enclosure, which offers an Ethernet connection. This allows the integration into a standard 

19-inch rack, or it can be used as table-top instrument. 

It is also possible to use a standard Serial Server to connect all our devices to an Ethernet interface. 

We have tested devices from Lantronix (ex. XPort or UDS1100) and Moxa (ex. NPort 5130). Feel free 

to contact us if you are looking for application examples. 

2.3.3 CANopen 

This device supports CANopen according to CiA 301. Please refer to the TEC Controller Communication 

Protocol 5136 document for further details 

2.4 Operating the Power Stage 

2.4.1 Theory of Operation 

The output stage controller outputs either the desired 

voltage or the desired current, depending on which 

value first runs in its limitation. It works in a way like a 

lab power supply with current and voltage limitation. 

The output stage works in the two sourcing quadrants, 

shown on the left side. The polarity is defined by the ISET 

value. This means USET is always entered positive and 

the ISET can be set positively or negatively. 

For this example, the settings are set to: 

Output Stage Input Selection: Current/Voltage 

Fixed Current: 5 A 

Fixed Voltage: 10 V 

 

In one condition a 10 Ohm Resistor is connected. In this 

case the output stage reaches the 10 V limitation before 

the 5 A limitation is reached. This means the output stage outputs 10 V at 1 A. 

In the other condition, a 1 Ohm Resistor is connected. In this case the output stage reaches first the 5 

A limitation. This means the output stage outputs 5 V at 5 A. 

Figure 8: Theory of Operation example sourcing quad-
rants visualization. 

https://www.meerstetter.ch/
https://www.meerstetter.ch/products/systems-software-accessories/devices/ltr-1200
https://www.meerstetter.ch/products/systems-software-accessories/devices/ltr-1200
https://www.meerstetter.ch/customer-center/downloads/category/35-latest-communication-protocols
https://www.meerstetter.ch/customer-center/downloads/category/35-latest-communication-protocols
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2.4.2 Output Stage Controller Settings 

The output stage of a channel can be controlled by two sources: 

• "Current/Voltage": Values are read from the non-volatile memory (flash). 

• "Temperature Controller": The current and voltage values are calculated by the controller as 

a function of temperature and other information. 

The channel's output is activated by the "Output Enable" parameter in the "Temperature Controller" 

or the main window. "Output Enable" settings are saved to the flash and remain active after a device 

power cycle or reset. 

• In "OFF" mode, the enable status is set to disabled. 

• In "ON" mode, the enable status is set to enabled. 

• In "HW Enable" mode, the enable status is read from a user defined GPIO. Please refer to 

chapter 6.1 GPIO1- GPIO10 Control Signals for detailed information. 

The "Fixed Output Values" are read when the TEC Controller channel is used as "Current/Voltage": 

• The sign of the "Fixed Current" parameter determines the polarity of both the current and 

voltage. 

• "Fixed Voltage" only accepts positive values. 

The "Output Stage Limits" are safety settings that limit the TEC Controller's output power to protect 

the connected Peltier elements or other components. 

Refer to the document TEC-Family Communication Protocol 5136 for more information all available 

parameters. 

https://www.meerstetter.ch/
https://www.meerstetter.ch/customer-center/downloads/category/4-communication-protocols
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2.5 Firmware Updates 

2.5.1 Standard Update Procedure 

You can download the firmware (contained in the MSI software package) from our website and update 

TEC Controllers using the TEC Configuration Software. 

The Configuration Software and the TEC Controller firmware are strongly related. Only when a TEC 

Configuration Software and a TEC Controller firmware with a matching Version Number are used the 

full functionality can be guaranteed. However, it is usually possible to connect to an old TEC Controller 

firmware with a new TEC Configuration Software version and vice versa. Functionality will be limited, 

but firmware updates are possible. 

Matching version numbers: All our publicized software have a version number similar to this: "vX.YZ". 

It is important that at least X and Y is matching. Z may be different. 

Follow these steps to update devices: 

• Read the TEC Software Release Notes document. 

• Backup the current configuration. This is important because it is possible that the current con-

figuration will be lost during the update. 

• In the main window click on "Device → Firmware Update" in the menu bar. 

• Click on "Select *.hex File" and choose the new .hex file. 

• Click on "Start Update Firmware" to load the new firmware on the device. 

• The TEC Controller will reboot once the update has completed. 

• You can check the firmware version in the "System" window. 

• Re-import the before exported .xml configuration file (if necessary). 

• Fill missing parameter values into new parameter fields (if applicable). 

• Check whether all parameter settings still match your expectations. Consult the TEC Software 

Release Notes as well as the TEC Controller Communication Protocol documents to learn what 

parameters have been changed. 

  

https://www.meerstetter.ch/
https://www.meerstetter.ch/customer-center/downloads/category/31-latest-software
https://www.meerstetter.ch/customer-center/downloads/category/31-latest-software?download=30:tec-family-tec-controllers-software-release-notes
https://www.meerstetter.ch/customer-center/downloads/category/31-latest-software?download=30:tec-family-tec-controllers-software-release-notes
https://www.meerstetter.ch/customer-center/downloads/category/31-latest-software?download=30:tec-family-tec-controllers-software-release-notes
https://www.meerstetter.ch/customer-center/downloads/category/35-latest-communication-protocols?download=6:tec-family-mecom-communication-protocol
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2.5.2 Upgrade Firmware from a Version below 6.00 

With the release of firmware v6.00 the default software to configure our devices from a Microsoft 

Windows operating system was switched from the previous TEC Service Software to the new TEC Con-

figuration Software. This breaking change also means that to upgrade from a firmware version below 

v6.00 to a version equal to or higher than v6.00 it is necessary to pay attention to a few key points 

depending on the current firmware version running on the device. Please read the respective condi-

tions in Table 2. 

Important notes: Before upgrading your device to firmware v6.00 please read what has been changed 

in the TEC Software Release Notes document first, as there where multiple breaking changes intro-

duced with this new version. Furthermore, please export your current configuration (.ini) using the TEC 

Service Software before the upgrade. Downgrading the firmware from v6.00 to an older version is only 

possible with the assistance of a Meerstetter Engineering employee! 

Table 2: Firmware Upgrade Conditions 

Current Firmware Version Upgrade Conditions 

Lower than v5.00 Direct upgrade is not possible, the device needs to be sent back to 
Meerstetter Engineering for the upgrade. Please contact the man-
ufacturer if you would like to upgrade your device. 

Equal to v5.00 or v5.01 First update to firmware v5.10 by downloading the TEC Service 
Software v5.10 from the download section of our website and up-
date the firmware using the included firmware file (.hex) through 
the "Device Boot Loader" in the "Maintenance" tab of the TEC Ser-
vice Software. 
Afterwards, follow the upgrade steps below to upgrade the firm-
ware from v5.10 to v6.00. 

Equal to v5.10 Download the TEC Configuration Software v6.00 from the down-
load section of our website. Upgrade the firmware to v6.00 by fol-
lowing the steps in chapter 2.5.1 Standard Update Procedure. 

 

https://www.meerstetter.ch/
https://www.meerstetter.ch/customer-center/downloads/category/31-latest-software?download=30:tec-family-tec-controllers-software-release-notes
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3 Temperature Measurement 

This chapter covers the "HR Input x" and "LR Input x" windows. "HR" stands for "High Resolution", 

which is often also referred to by "Object Measurement" and "LR" stands for "Low Resolution", which 

is often also referred to by "Sink Measurement". 

Every TEC Controller features multiple temperature sensor measurement inputs used for temperature 

controlling: 

• The HR inputs (23-bit ADC) usually measure temperature of an object. 

Supported temperature sensors: 

o PT100 

o PT1000 

o NTC 

o Voltage output sensors 

• The LR inputs (12-bit ADC) usually measure temperature of a heatsink and are optionally used. 

Supported temperature sensors: 

o NTC 

The TEC Controller supports two types of temperature sensors: passive resistance temperature detec-

tors (RTD), also known as thermistors, and voltage output temperature sensors. The passive resistance 

temperature sensor (RTD) has an accurate resistance per temperature relationship. Hence, to measure 

the temperature of some object, a sensor is fixed to it and the TEC Controller determines the resistance 

of the sensor or measures the output voltage, respectively. 

https://www.meerstetter.ch/
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3.1 High Resolution Measurement (HR Input) 

As a user you define the temperature working range and you choose a sensor type. The supported 

sensor types for the HR input are the following: 

• NTC sensors (negative temperature coefficient, e.g., NTC10k sensors) 

• Platinum sensors PT100 or PT1000 (positive temperature coefficient) 

• Voltage output sensors 

The HR input has an onboard reference resistor RS which is used by the measurement circuitry. This 

reference resistor shown in Table 3 is defined as sensor configuration within the hardware configura-

tion upon ordering and defines the possible temperature measurement range. 

Table 3: Default configuration parameters for RTD temperature sensors. 

Device Type 
Sensor 

Configuration 
RS (kΩ) 

RP 
(kΩ) 

TEC-1089 
TEC-1090 
TEC-1122 
TEC-1123 

PT100 1.5 ∞ 

PT1000 3.6 ∞ 

NTC18K 18 ∞ 

NTC39K 39 ∞ 

NTC56K 56 ∞ 

NTC1M 39 39 

NTC 39 39 

VIN1 Diode3   

TEC-1091 
TEC-1092 
TEC-1161 
TEC-1162 
TEC-1163 
TEC-1166 
TEC-1167 

PT100 1.5 ∞ 

PT1000 3.6 ∞ 

NTC56K 56 ∞ 

NTC1M 39 39 

NTC 39 39 

VIN1 Diode3 ∞ 

VIN24 Shorted ∞ 

 

Refer to the TEC Controller datasheets for wiring diagrams for sensors and temperature measurement 

ranges. 

 

3 In case of voltage output temperature sensors, RS is a Schottky Diode. 
4 Not supported on TEC-1092 devices. 

https://www.meerstetter.ch/
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3.1.1 NTC Sensors 

3.1.1.1 Example NTC Configuration 

This example visualizes the relationship between temperature sensor type and sensor configuration. 

As an example, we choose a TEC-1091 with an NTC56K sensor configuration. As temperature sensor 

(type) we select a NTC B25/100=3988K R25=10k thermistor. The first value describes the temperature-

resistance relationship, and the second value indicates that the sensor has a resistance of 10 kΩ at 25 

°C. 

According to the TEC-1091 datasheet, it's possible to measure a sensor resistance up to 55742 Ω for 

the NTC56K configuration, which corresponds to a temperature of -10.1 °C. The lowest possible re-

sistance is 105 Ω, which corresponds to 176 °C. 

3.1.1.2 Configuration of NTC Sensors 

In case of an NTC sensor the temperature to resistance characteristics need to be entered manually by 

the user. 

For each NTC temperature acquisition channel choose three temperatures (lower, middle, and upper) 

spanning the measurement range to be covered. Look up their corresponding resistances in your sen-

sor's data sheet. Three temperature-resistance pairs are needed to model a characteristic tempera-

ture-resistance curve using the Steinhart–Hart equation5 

1

𝑇
= 𝐴 + 𝐵 ln(𝑅) + 𝐶(ln(𝑅))3 

where T is the temperature (kelvin), R is the resistance (ohms), A, B, and C are the Steinhart–Hart 

coefficients. 

Enter the three value pairs in the "HR Input x" or "LR Input x" window within the field "NTC Sensor 

Characteristics" of the "Temperature Conversion" box when the "Conversion Type" is set to "NTC". 

This curve will be most precise for small ranges (lower point to upper point) that are centered about a 

working point / nominal temperature (middle point). 

3.1.2 PT100 / PT1000 Sensors 

PT100 and PT1000 temperature probe characteristics according to DIN EN 60751 are device internally 

stored and the user does not need to configure anything in the Configuration Software for the tem-

perature measurement. 

 

5 More information about the Steinhart–Hart equation on Wikipedia. 
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3.1.3 Voltage Output Sensors 

The TEC Controller can use a Linear Voltage Output Temperature Sensor to measure the HR input. The 

characteristics of the sensor must be entered manually by the user.  

The values for Reference Temp, Reference Voltage and Temperature Slope are needed, they can be 

found in the datasheet of the sensor. Enter the three values in the "HR Input x" window within the 

field "Voltage to Temperature Conversion", which is visible when the "Conversion Type" field is set to 

"Voltage". 

In the Document TEC Application Note - Voltage Output Temperature Sensors (-VINx) Information 

about how to connect the Sensors to the TEC Controller can be found. The Voltage Measurement 

Range of each TEC Controller is listed in the corresponding datasheet. 

3.1.4 Changing the Measurement Configuration 

In case you would like to change the temperature sensor configuration of the HR input (as an example 

from PT100 to NTC1M), hardware modifications and configuration changes by software are necessary. 

The configurations changes can be made by yourself, please contact us, if you don't want to change 

the configuration by yourself. We recommend that the changes are made by us since we can guarantee 

a properly performed conversion and we can recalibrate the TEC Controller. 
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3.1.4.1 Changing between a PT100/PT1000 and a NTC Measurement Configuration 

Please follow these instructions: 

• Replace the temperature reference resistor RS
6. The requirements for this resistor are: 0.1% 

tolerance, 5 ppm/°C temp. coefficient, 100 mW power rating, 0805 footprint. In the case of an 

NTC1M configuration, use a 39 kΩ resistor according to Table 3. 

• Only in case of the NTC1M configuration solder the resistor RP parallel to the sensor input. Use 

the same resistor type as RS. 

• If the change is from four-wire measurement7 (PT100 and PT1000) to two-wire measurement 

(NTC), then add jumpers to the measurement input. Remove the jumpers if the change is from 

two wires to four wires. The position is shown in the section Pin Configuration of the corre-

sponding datasheet for the TEC Controller. Please note that the TEC-1092 exclusively works 

with four-wire measurement. 

• Perform the following changes in the Configuration Software: 

o Choose the option "NTC" in the "HR Input x" window within the "Hardware depending 

Default Settings" menu. 

o Click on the "Set Default" button. 

o Persist the settings on the device. 

o Reset the device. 

Now you can check the object temperature measurement limits in the "HR Input x" window. 

 

Figure 9: New temperature measurement limits for NTC configuration of a TEC-1091. 

  

 

6 Refer to the datasheet for the position of RS. Possible choices for RS are: 
1.5 kΩ: WELWYN PCF0805-13-1K5-B-T1 
3.6 kΩ: WELWYN PCF0805-13-3K6-B-T1 
18 kΩ: WELWYN PCF0805-13-18K-B-T1 
39 kΩ: WELWYN PCF0805-13-39K-B-T1 
56 kΩ: WELWYN PCF0805-13-56K-B-T1 
7 Either two or four wires are used to connect the sensor, depending on the type. See TEC Controller datasheets for wiring. 
More information about four-wire measurement on Wikipedia. 
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3.1.4.2 Changing to a VIN Measurement Configuration 

In case a voltage output sensor replaces another sensor type, follow these steps: 

• Jumpers at the measurement inputs need to be removed. 

• For VIN1 replace RS by a Schottky diode.8 

• For VIN2 replace RS by 0 Ohm resistor and set the 5V jumper to apply 5V to IA. 

• Perform the following changes in the Configuration Software: 

o Load the option "VIN1" or "VIN2" in the "HR Input x" window within the "Hardware 

depending Default Settings" menu. 

o Click on the "Set Default" button. 

o Persist the settings on the device. 

o Reset the device. 

• Enter the three values in the window "HR Input x" in the field "Voltage to Temperature Con-

version" according to your sensor. This field is visible when the "Conversion Type" field is set 

to "Voltage". 

  

 

8 A possible choice is Toshiba CUS520,H3F (The voltage drop should be in the range of 0.1V to around 0.3V) 
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3.1.5 Temperature Measurement Behavior 

The behavior of the temperature measurements can be configured in the "HR Input x" and respectively 

the "LR Input x" windows. 

Using the parameters in the "Surveillance" box it is possible to control the temperature measurement 

conditions that will result in the TEC Controller going into an error state. These are safety measures as 

the TEC Controller will shut off all outputs when it goes into an error state. 

Table 4: Parameter "ADC Limit Errors" 

Option Description 

None Default setting. ADC monitoring is disabled. No errors are gener-
ated when limits (→ "Upper Threshold" and "Lower Threshold") 
are reached. 

Upper Only ADC monitoring is only enabled using the "Upper Threshold". 

Lower Only ADC monitoring is only enabled using the "Lower Threshold". 

Both ADC monitoring is enabled and considers all error thresholds. 

 

Table 5: Parameter "Temp. Limit Errors" 

Option Description 

None Default setting. Temperature monitoring is disabled. No errors are 
generated when limits (→ "Upper Threshold" and "Lower Thresh-
old") are reached. 

Upper Only Temperature monitoring is only enabled using the "Upper thresh-
old". 

Lower Only Temperature monitoring is only enabled using the "Lower thresh-
old". 

Both Temperature monitoring is enabled and considers all error thresh-
olds. 

 

The sampling frequency specifies the frequency of the measurement cycle. This parameter can be ad-

justed in the "HR Input x" windows within the "Analog Digital Converter" box. The control speed adapts 

to the sampling frequency of a HR Input if it is assigned as "Object Source Selection" for a TEC Channel. 

For all other "Object Source Selection" sources the control speed is always 10Hz. 

Table 6: Parameter "Sampling Frequency" 

Option Description 

10Hz Default setting. 10 Hz measurement frequency. 

80Hz/90Hz 90 Hz measurement frequency for TEC-1092, TEC-116x and TEC-
1091 (hardware version >=3.00) and 80 Hz for other devices. 

1Hz 1 Hz measurement frequency. 
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3.1.6 Analog-to-Digital Converter Self-Check Function 

It is possible that a damaged analog-to-digital converter (ADC) delivers incorrect temperature meas-

urement results, which under certain circumstances remain undetected. To resolve this issue an ADC 

self-check function has been added. This function must be manually activated by the user or can be 

configured to be periodically executed with a user defined interval. When configured to run periodi-

cally, the first measurement is performed 10 seconds after startup. It is not recommended to run the 

periodic check in time intervals of less than 10 seconds. 

While the ADC self-check function is running the temperature measurement results are not updated, 

so care must be taken to not run the self-test function while critical operating conditions are present 

or during autotuning. A self-check takes approximately 300ms. 

The test function measures the supply voltage of the ADC as well as the current through the refer-

ence resistor and the voltage at the voltage reference input. If one of those values is out of range an 

error is thrown. The current measurement error can be disabled by setting the parameter "Error on 

IRs fail" to No. 

The results of all measurements are stored and can be read for further evaluation. 

It is not recommended to use the ADC self-check function when a reference resistor larger than 46kΩ 

is used as the results might be unreliable. Because of hardware differences, the sensor current can-

not be measured when a voltage output sensor is used (-VIN1/2 version). In this case, only the refer-

ence voltage is measured and checked. 

To start a check the parameter "Trigger Self Check" must be set to 1. After the check has finished, 

this value is automatically reset to 0. Writing a 0 does not cancel the test. To enable the periodic 

check the parameter "Periodic Check" must be set to the required period in seconds. If the value is 0 

no periodic check is performed. 

The ADC self-check function can be configured in the "HR Input x" window. 

3.2 Low Resolution Measurement (LR Input) 

The Low Resolution Temperature Measurement or LR Input can only accommodate NTC sensors. This 

input is less configurable and uses on the MCU-integrated 12bit ADC. The circuit's reference resistor 

RV is factory-set to 5.6 kΩ. 
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3.3 Assignment of Measurement Inputs to Channels 

The various Measurement Inputs that a TEC Controller offers can be freely assigned to any TEC Chan-

nel. This provides a lot of flexibility when it comes to designing a system. 

3.3.1 Object Source Selection 

The assignment of the "Object Source Selection" for a TEC Channel can be made in the main window 

of the TEC Configuration Software by clicking on the little configuration buttons that will open a popup: 

 

Figure 10: Configuration Popup for TEC Channel 1 in the main window. 

Table 7: Parameter "Object Source Selection" 

Option Description 

HR 1 The temperature of HR 1 (High Resolution Measurement Circuit 1) 
is used for temperature controlling. 

HR 2 The temperature of HR 2 (High Resolution Measurement Circuit 2) 
is used for temperature controlling. 

LR 1 The temperature of LR 1 (Low Resolution Measurement Circuit 1) 
is used for temperature controlling. 

LR 2 The temperature of LR 2 (Low Resolution Measurement Circuit 2) 
is used for temperature controlling. 

LR 3 The temperature of LR 3 (Low Resolution Measurement Circuit 3) 
is used for temperature controlling. 

LR 4 The temperature of LR 4 (Low Resolution Measurement Circuit 4) 
is used for temperature controlling. 

Device The Device Temperature of the TEC Controller is being used. 

External The temperature can be fed over a data communication interface. 
The temperature value needs to be written to the parameter "Ob-
ject External Temperature" (ID 52200). Keep in mind that it is rec-
ommended to write the temperature value to this parameter at 
least once every 100ms. If it is not written to within a timeout pe-
riod of 5 seconds, it will automatically reset to 'NaN' (Not a Num-
ber), which stops the temperature regulation and leads to no more 
output current being supplied. 
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3.3.2 Sink Source Selection 

The assignment of the "Sink Source Selection" for a TEC Channel can be made in the main window of 

the TEC Configuration Software by clicking on the little configuration buttons that will open a popup: 

 

Figure 11: Configuration Popup for TEC Channel 1 in the main window. 

Heat sink measurement improves the performance of the integrated power optimization routine but 

is optional. It is possible to use a fixed temperature value as reference if no external heat sink meas-

urement is used. This can be done in the TEC Channel configuration popup in the main window by 

setting by setting the "Sink Source Selection" to "Fixed" and entering the desired reference tempera-

ture in the "Sink Fixed Temperature" field to the right of it. 

Table 8: Parameter "Sink Source Selection" 

Option Description 

HR 1 The temperature of HR 1 (High Resolution Measurement Circuit 1) 
is used for temperature controlling. 

HR 2 The temperature of HR 2 (High Resolution Measurement Circuit 2) 
is used for temperature controlling. 

LR 1 The temperature of LR 1 (Low Resolution Measurement Circuit 1) 
is used for temperature controlling. 

LR 2 The temperature of LR 2 (Low Resolution Measurement Circuit 2) 
is used for temperature controlling. 

LR 3 The temperature of LR 3 (Low Resolution Measurement Circuit 3) 
is used for temperature controlling. 

LR 4 The temperature of LR 4 (Low Resolution Measurement Circuit 4) 
is used for temperature controlling. 

Device The Device Temperature of the TEC Controller is being used. 

Fixed The temperature can be set to a fixed temperature value as refer-
ence when no sink sensor measurement is used. Define this tem-
perature value through the "Sink Fixed Temperature" parameter 
(ID 52201). 
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4 Temperature Control 

This chapter covers the "Temperature Controller" window of the TEC Configuration Software. 

4.1 Theory of Operation 

The following part is a short description of the temperature control mechanism in the TEC Controller. 

 
Figure 12: Temperature control functional overview. 

• The TEC Controller measures periodically the object temperature and the temperature of the 

heat sink (optional) using temperature sensors. The temperature measurement is also active 

when the temperature controller is not. 

• The target temperature is the setpoint for the PID controller. 

• The temperature controller calculates the needed output power based on the target temper-

ature, heat sink temperature and actual object temperature. It's possible to use a fixed value 

for the heat sink temperature (default setting). 

• The output stage has two possible input parameters, either the value from the temperature 

controller or a static current and voltage. 

• To keep the output stage in boundaries, output limits are set. 

• The output stage is enabled and disabled by the enable parameter. 

• Finally, the output stage powers the Peltier element. 

4.1.1 PID Control Parameters 

• The proportional term Kp defines the portion [%] of normalized cooling/heating power that 

can be used to correct the difference [°C] between actual and nominal temperature. Assuming 

the temperature difference between actual and nominal is 2°C and Kp is set to 15%/°C, then 

the output will feed 30% power to the Peltier element. 

• The integral term Ti defines the reset time [s] the regulator is allowed to take for correcting a 

given control deviation. The effect of Ti is weak for large values and strong for small values. 

Set Ti to 0s to disable the integral term. 

• The derivative term Td opposes changes in control deviation, weighed by unit time [s]. The 

dampening effect of Td increases with larger values. By default, the D component is bypassed 

(0s). 

• The value "D Part Damping PT1" is damping the resulting value of the derivative term. It may 

be useful for very slow thermal models which result in high Td times. 
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The suggested PID values are starting values that proved to work reasonably well at factory. At a later 

stage, you can optimize them for your application and system. This can be done manually or by using 

the auto tuning function in the Configuration Software. 

4.1.2 Temperature Ramp 

For certain thermal masses, the systems response to cooling and heating power may be slow and thus 

reaching thermal stability takes some time. On power-up large changes from an initial to a target tem-

perature may be required. To minimize the overall time to reach thermal stability, the sudden jump in 

temperature is replaced by a generated three-part ramp. 

 

Figure 13: Temperature vs time change from an initial temperature to a target temperature, showing the three-part ramp. 

First the nominal temperature is smoothly guided away from the starting value by a sine-shaped curve. 

After leaving the "Proximity Width" the temperature follows the faster, linear ramp—the "Coarse 

Temp Ramp"—at the maximum possible rate. Once again within the "Proximity Width", the nominal 

temperature follows again a sine-shaped curve towards the target temperature. Using this ramping 

scheme, over- and undershoots in respect to the target temperature will be minimized and the final 

temperature is stabilized more quickly. 

If a Linear Ramp without the sine shaped curves is required, the Proximity width can be set to 0. 

It is unlikely that your system can follow the default "Coarse Temp Ramp" slope of 1 °C/s. This initial 

setting allows the user to get a feeling for the system's thermal inertia, and it permits observation of 

the nominal temperature trace in the graph. 

Nominal temperature ramping allows the usage of more aggressive PID values, typically required to 

properly react to external disturbances. Please note that the ramping and PID parameter sets are in-

dependent. 

4.2 Control Modes 

The TEC Controller supports the following three control modes, available in the field "Thermal Model 

Selection": 

• Peltier, Full Control: The Peltier element heats and cools, powered by the bipolar current. 

• Peltier, Heat/Cool Only: The TEC Controller tries to keep the temperature between the " Pel-

tier, Heat/Cool Only Boundaries". If the actual temperature is somewhere between these 

boundaries, the TEC Controller does not power the Peltier element. 

• Resistor, Heat Only: If a resistive heater is used, only heating is possible. 

Depending on what you choose, either "Peltier Characteristics" or "Resistor Characteristics" parame-

ters will be implemented (from either of the two boxes underneath). 
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4.3 PID Auto Tuning (PID Parameter Optimization) 

The "Auto Tuning" window in the Configuration Software provides a powerful tool for system optimi-

zation. The results are optimized PID controller and ramping parameter sets (see chapter 4.1 Theory 

of Operation). The "Auto Tuning" window can be accessed through a button below the "Temperature 

Control" box in the "Temperature Controller" window of the channel that should be optimized. 

Precautions: 

• If you have set the "Thermal Model" in the "Temperature Controller" window to "Peltier, 

Heat/Cool Only" mode the Auto Tuning will not work unless the controller is actively regulat-

ing, i.e., the current object temperature is outside the two defined boundaries. It rarely makes 

sense to perform the Auto Tuning in such circumstances. Instead, consider setting the "Ther-

mal Model" to "Peltier, Full Control" and the "Target Temperature" to a value between the 

boundaries to perform the Auto Tuning and afterwards set the "Thermal Model" back. 

• If you have set the "Thermal Model" in the "Temperature Controller" window to "Resistor, 

Heat Only" mode the Auto Tuning will not work unless the controller is actively heating, i.e., 

the current object temperature is below the "Target Temperature". In most cases it makes 

more sense to try and manually optimize the PID settings instead of performing the Auto Tun-

ing in this mode. 

• If the "Temperature Controller" is operating in Unipolar Mode the actor must be naturally con-

trolled, i.e., it must be either heating or cooling when the Auto Tuning function is started. 

Follow these steps to optimize your system: 

• The "Thermal Model" in the "Temperature Controller" window should be set to "Peltier, Full 

Control". 

• The temperature measurement should work reliably, prior to using the auto tuning function. 

This means that the correct temperature is measured, and the fluctuation of the temperature 

value is small (i.e., < 5 mK). 

• Ensure that the Peltier element is connected with the correct polarity. 

• Peltier characteristics (in the "Temperature Controller" window) must be set correctly accord-

ing to the Peltier element's datasheet. 

• Set limits for current and voltage in the "Temperature Controller" window. 

• Make sure that the output stage is not running in its voltage limitation. 

• Set the temperature limits in the "HR Input x" window, to avoid damage of anything in contact 

with the Peltier element. 

• Set the desired object target temperature. If you will use multiple target temperatures, use 

the highest one. This leads to more reliable PID values in most cases. 

• The channel to be optimized must already be successfully operating in the mode "Temperature 

Controller". This means that the target temperature is reached with the standard PID settings 

(Kp = 10; Ti = 300; Td = 0). 

• Before you start the auto tuning process, it is recommended to note the currently used PID 

values in the "Temperature Control" box and the parameters in the field "Nominal Tempera-

ture Ramp" or to export the device configuration. 

• During the optimization process, no other heating or cooling source other than the driven Pel-

tier element must be active, to not disturb the process. 

• Enable the temperature controller by setting the option "Output Enable" in the "Temperature 

Controller" or main window to "ON". 

• Important: Wait until the target temperature is reached and the temperature has equalized. 

• Select the "Thermal Model Speed": 
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o "Fast Model": Use this setting if you have only a small thermal load and the target 

temperature is usually reached within a minute. Always start with this setting. 

o "Slow Model": Use this setting if you have a huge thermal load and the target temper-

ature is usually reached within some minutes. 

• Now the status indicator reads "Idle". Press the "Start" button. 

• The TEC Controller initiates a cooling-heating pattern that will reveal specific system infor-

mation. The progress of the auto tuning procedure is indicated by the advancing status bar. 

You can observe the applied current patterns and resulting temperature variations in the 

"Chart" window if you display the respective parameters within it. 

• Upon ending with the status "Successful" the TEC Controller will continue regulating the tem-

perature. 

• Finally, the results of the optimization are displayed in the fields within the "Check Tuning Re-

sults" box. You can accept and use the new parameters by clicking on the "Write Results" but-

ton. 

4.3.1 Trouble Shooting and Enhancements 

Table 9: Possible reasons and possible solutions for common problems during auto tuning. 

Problems Possible Reasons Possible Solutions 

There is too much 
noise on the current 
output. 

Your thermal model is very 
slow. Therefore, large Ti and Td 
times are calculated for the PID 
controller. High Td times result 
in a very big amplification of 
every small temperature dif-
ference or noise. 

Set the "Thermal Model Speed" to "Slow 
Model" and start the auto tuning process 
again. 

Check "Use Slow PI Values" and click on 
"Write Results". These values run without 
differential part of the PID controller. 

Go to "Temperature Controller" window 
and set "D Part Damping PT1" to a lower 
value. (Too low values will result in a 
worse temperature control behavior) 

It takes too long until 
the desired target 
temperature is 
reached. 
 
The nominal temper-
ature ramp is too 
slow. 
 
The TEC Controller is 
not providing the 
maximum current to 
the Peltier element. 

After performing the Auto Tun-
ing, the "Nominal Temperature 
Ramp" settings ("Coarse Temp 
Ramp" and "Proximity Width") 
are taken form Auto Tuning 
recommendations. These rec-
ommended values are inten-
tionally slow values. The target 
is to prevent a temperature 
overshoot. Therefore, the PID 
controller must always be able 
to follow the nominal temper-
ature ramp. 

You may set "Coarse Temp Ramp" in the 
"Temperature Control" tab to a higher 
value. This will result in a faster nominal 
temperature ramp. 
 
You may set the "Proximity Width" to a 
lower value. 

Error 170: 
Less than xx% of pro-
gress advancement 
in xx minutes. 

The progress of the Auto Tun-
ing is determined upon several 
parameters. This error is gen-
erated when the process is too 
slow. 

Set "Thermal Model Speed" to "Slow 
Model" to have longer time periods. 

Let your thermal system cool down be-
tween two tuning attempts. Disable the 
power source to the Peltier element for 
several minutes. 
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Problems Possible Reasons Possible Solutions 

Error 171 / 172: 
Auto Tuning fails at 
three consecutive at-
tempts due to more 
than 40% discrep-
ancy in temperature 
/ time. 

The tuning process executes 
several swing periods to deter-
minate the results. This error is 
generated if values of these 
swing periods are too differ-
ent. 

Do not change the thermal load during the 
tuning process. 

Make sure the thermal object is isolated 
from any changing air flows. 

Error 173: 
Auto Tuning detects 
that the PID temper-
ature controller is in 
limitation. 

TEC Controller is not Running 
in Temperature Controller 
Mode. 

Make sure that the TEC Controller's out-
put stage is "ON", and that the TEC Con-
troller's "Output Stage Control Input" is 
set to "Temperature Controller". 

The Target Temperature has 
not been reached. The Tem-
perature Controller is running 
in its output limitation. 

Make sure you use suitable default PID 
Settings. These are described in the Con-
figuration Software "Auto Tuning" win-
dow. 

Make sure the target temperature has 
been reached and equalized before you 
start the Auto Tuning process. 

Auto Tuning is stuck 
in "Preparation" sta-
tus 

The "Thermal Model Selec-
tion" is set to either the "Pel-
tier, Heat/Cool Only" or the 
"Resistor, Heat Only" mode. In 
those modes the Auto tuning 
can only work while the TEC 
Controller is actively regulating 
the temperature. 

Make sure that the temperature is being 
actively regulated before starting the Auto 
Tuning process. 

If you are using the "Peltier, Heat/Cool 
Only" mode consider setting the "Thermal 
Model" to "Peltier, Full Control" and the 
"Target Temperature" to a value between 
the boundaries to perform the Auto Tun-
ing and afterwards set the "Thermal 
Model" back. 

If you are using the "Resistor, Heat Only" 
mode it makes more sense in most cases 
to try and manually optimize the PID set-
tings instead of performing the Auto Tun-
ing in this mode. 
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4.4 Operating Modes & Parallel Operation 

TEC Controllers having two output stages can operate them independently or in a combination in var-

ious modes. In the main window the "Operating Mode" can be set to the following options: 

• Bipolar: This is the default setting. Each channel can use any temperature measurement and 

uses its own output stage. Each channel can output positive and negative current / voltage. 

 

Figure 14: Example of a dual-channel TEC Controller controlling two thermal loads, each with their own Peltier 
element, heat sink, HR, and LR temperature measurements in Bipolar mode. 

• Parallel Bipolar Individual: The output current, output voltage values as well as all output 

stage limits of channel 2 are set to the ones currently active for channel 1. The "Output Stage 

Enable" status of CH1 is also valid for both channels. 

In practice, this means that the CH2 output stage will follow the settings defined for the CH1 

output stage. 

 

Figure 15: Example of a dual-channel TEC Controller controlling two thermal loads mounted on a single heat sink 
with only one object and one heat sink temperature measurement in Parallel Bipolar Individual mode. 
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• Parallel Bipolar Common: This mode allows for current doubling. The outputs of the two out-

put stages are connected to one common load. If CH1 is working as "Temperature Controller", 

the PID controller is aware it can dispose twice the nominal current, to which each channel will 

provide an equal amount. 

 

Figure 16: Example of a dual-channel TEC Controller controlling a single thermal load by connecting both outputs 
to it, which allows for current doubling in Parallel Bipolar Common mode. 

• Unipolar: The output stages are each split into two channels each, which can only either out-

put positive or negative current / voltage. This allows the temperature controlling of more 

loads. The LR inputs can also be used to measure the temperatures of the additional loads. 

 

Figure 17: Example of a dual-channel TEC Controller whose outputs have both been split so that they can each 
control two thermal loads in Unipolar mode. 
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• Mixed: The output stages are split into one bipolar channel and two unipolar channels. This 

mode is only supported on devices with more than one output stage. 

 

Figure 18: Example of a dual-channel TEC Controller that uses one output in Bipolar mode to control a single thermal 
load and one output in Unipolar mode to control two additional thermal loads. 
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5 Charting and Data Logging 

5.1 Charts/Graphs 

The graphs support multiple interaction options to adjust the view. The following interaction options 

can also be seen by hovering over the  symbol in the top-right corner of the graph windows: 

Option Keyboard Shortcut 

Show Datapoint Details Left Mouse Button 

Pan Right Mouse Button 

Zoom Mouse-Wheel 

Zoom by Rectangle Ctrl + Right Mouse Button 

Reset Double-Click Middle Mouse Button 

Double-Click Ctrl + Right Mouse Button 

 

5.1.1 Graph 

The "Graph" window offers a convenient way of mid-term system characterization, e.g., for observing 

stability, or for optimizing PID control or nominal temperature ramping parameters. 

All numerical parameters present on a TEC Controller can be displayed in any of the graphs. To display 

a parameter in any of the two graphs, click on the "Graph Parameter Settings" button in the "Graph" 

window, which will open the "Application Settings" window. In this window all parameters of the TEC 

Controller are listed in a table within the "Graph Parameter Configuration" box. In this table a param-

eter can be shown by clicking on the checkbox in the "Show" column and it can be assigned to a specific 

graph via the dropdown menu in the "Assignment" column. 

Furthermore, a parameter can also be shown in the graph by enabling the "Show in Graph" checkbox 

within its tooltip in the software. 

By default, the graph will display the datapoints within a 10-minute range and it will always scroll the 

graph area automatically should the datapoints move out of the maximum boundary of the X axis 

(time). The time range can be adjusted by modifying the "Graph Area [min]" setting and the automat-

ically scrolling behavior can be disabled by enabling the "Freeze Graphs" option within the "General 

Settings" box. 
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Figure 19: "Graph" window with its configuration in the "Application Settings" window on top. 
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5.1.2 Real Time Graph 

When a TEC Controller in combination with a small thermal load (e.g., a sensor) is used, the object 

temperature may change quickly. To examine the behavior of a fast-changing system, the TEC Config-

uration Software features a DSO-like "Real Time Graph" feature. 

• Compared to the normal chart, the real time chart has a higher temporal resolution and can 

record values down to a 10-millisecond interval. 

• The Real Time Graph works using a Parameter subscription-based approach. It is possible to 

subscribe to any parameter that is available on the controller, which results in the controller 

recording any parameter writes of these parameters specifically for the Real Time Graph and 

Real Time CSV Log. 

o Parameters can be subscribed to from within the "Application Settings" window, which 

can be opened by clicking on the "Graph Parameter Settings" button in the "Real Time 

Graph" window. 

o Up to 16 parameters can be subscribed to at the same time. 

o In the "Real Time Graph Configuration" section in the "Application Settings" window it 

is possible to load a Default Profile that contains a few common parameters for the 

Real Time Graph feature to subscribe to. It is possible to also add or remove parame-

ters that should be subscribed to after loading a default profile. 

o  The parameters that should be subscribed to are listed in the table within the "Data 

Capture Configuration" section. Together they are what is referred to a "Capture Con-

figuration" and to load this configuration onto the TEC Controller, so that it can start 

collecting data according to it, the "Update Capture Configuration" button needs to be 

pressed. 

o In the "Capture Configuration" table it is also possible to configure the following op-

tions for each parameter: 

 

Option Description 

Inhibit Time The inhibit time (capture delay time) specifies the mini-
mum length of time that must be allowed to elapse be-
tween the capture of two of the same value. 
It can be used to implement a transmit filter that does 
not increase the reaction time for relatively new input 
alterations but is active for writes that follow immedi-
ately afterwards. 

Assignment Choose whether the parameter should be shown in 
graph 1 (top) or graph 2 (bottom). 

OnWrite Disclaimer: This option is only relevant for the CSV ex-
port of the Real Time Graph data. 
If this option is null (not set), then values are written to 
the file, whenever one value has been written. This 
might lead to a situation, where the time step is not the 
same for every row. If this option is enabled, it is possi-
ble to write only to the file, if the value of the selected 
index has been written. This also means that this option 
can only be active for one parameter at a time. 
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o Once the TEC Configuration Software is closed the configured "Capture Configuration" 

is discarded and needs to be manually configured again. 

• Pressing the "Load Data" button in the "Real Time Graph" window displays the data recorded 

within the defined "Capture Time Frame [sec]" time section. 

 

Figure 20: "Real Time Graph" window with the configuration for the object temperature (top) as well as output current and 
output voltage (bottom). 
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5.2 Log 

For external plotting and data analysis, logged data can be exported to an .xlsx (Excel) or .csv (Comma-

separated values) file from the "Log" window. 

• Each log entry is timestamped. 

• At relaunch of the software the log is erased, and the log interval is set to the smallest value 

of 1 second. 

• The general data logging duration is limited to 10 hours. Afterwards, the data at the beginning 

of the log will be overwritten with any new log data (ring buffer). 

• The graph makes use of this log data for its datapoints. 

• For critical long-term monitoring we recommend exporting the log regularly and to relaunch 

the TEC Configuration Software occasionally (e.g., every couple of days). 

• The export of the logged data contains all data of every single parameter on the controller. 

• Certain parameters are logged only when they are changed (Setting parameters) and others 

are logged upon every interval tick (Monitor parameters). In the Excel log these two types of 

parameters are each divided into their own worksheets, but in the CSV log all values are com-

bined and written on each entry. This is why the CSV log can grow larger in file size in compar-

ison with the Excel log the more entries the log contains. 

5.3 Real Time CSV Log 

Real time data logging to .csv files is possible. 

• Data is transferred in a kind of stream from the TEC Controller to the TEC Configuration Soft-

ware. After starting the logging, the file is kept open by the TEC Configuration Software and 

continuously written to. The file is only closed when the logging has been stopped. 

• Every 10 milliseconds the TEC Controller will record the data of the parameters that are sub-

scribed to using the "Capture Configuration" of the "Real Time Graph" feature. 

• Every parameter present in the "Data Capture Configuration" in the "Application Settings" win-

dow is exported to the .csv file and marked with a time stamp. 

• When the "Fill" checkbox is not checked, the CSV output only writes the column values to the 

rows, which have changed. If it is checked all columns are always filled with values, even if a 

value has not changed in the last log record. If the value has not changed, it will just take the 

last recorded value available. 

Some adjustments are necessary within Microsoft Excel after the export due to the lack of formatting 

options in .csv files: 

1. Open the exported .csv file. 

2. Select the field C2. 

3. Double-click on the square in the bottom right corner → the column is filled with values. 

4. Copy your desired format from L1, e.g., "TT.MM.JJ hh:mm:ss.000" or the other one for users 

with a comma as decimal separator adjusted operating systems. 

5. Select the entire column C by clicking on the column's header. 

6. Go to the formatting options by right-clicking on the column and selecting "Format Cells…". 

7. Choose the category "Custom", paste the format copied prior and click OK → the time in the 

column C is now displayed in millisecond resolution. 

8. Analyze the data by using calculations and adding diagrams. 

9. Save the log as Excel file. 
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6 External Hardware 

6.1 GPIO1 – GPIO10 Control Signals 

The GPIO1–GPIO4 control signals are available on every TEC Controller model and can be used for 

general purpose I/O (GPIO) or for predefined functions. The functions described in Table 10 can be 

independently assigned to the GPIO signals in the "I/O" window. Many functions are separately avail-

able for both channels. For those functions, the corresponding channel can be chosen in the "I/O" 

window as well. For the functions which are not available separately this setting has no effect. 

Table 10: Available functions for the GPIO signals 

Function Name Description 

No Function The GPIOx has no function. 

Data Interface The GPIOx signal is used as digital I/O from the communication interface. Re-
fer to the document "TEC Controller Communication Protocol 5136" for more 
information. 
Not available individually for both channels. 

TEC OK The GPIOx signal is logic 1 if the TEC Controller is in the "Ready" or "Run" sta-
tus. 
Not available individually for both channels. 

Stable The GPIOx signal is logic 1 if the temperature of the corresponding channel is 
stable. 

HW Enable The GPIOx signal is used as input to enable the output of the channel. If the 
signal is logic 1, the TEC Controller is enabled. The value of parameter 2010 
will be overwritten with the value provided by the GPIO. 

Fan PWM The GPIOx signal is used as PWM output for the Fan Control feature. Only 
selectable for GPIO3 and GPIO4 (see chapter 0  
Fan for Heatsink Cooling). 
For this function, the "Hardware Configuration" is usually set to "Out Push-
Pull" to properly drive the PWM input of the fan. 

Fan Tacho The GPIOx signal is used as frequency input for the fan control feature (see 
chapter 0  
Fan for Heatsink Cooling). 
For this function, the "Hardware Configuration" is usually set to "IN Weak 
Up", because the tacho output of the fan usually has an open collector output. 

Rmp/Stable The GPIOx signal is logic 1 if the temperature of the corresponding channel is 
stable. The GPIOx signal toggles between 1 and 0 at 1 Hz, when the corre-
sponding channel is ramping to the target temperature. 

TEC Run The GPIOx signal is logic 1 if the TEC Controller is in the "Run" status. 
Not available individually for multiple channels. 

TempUp 
TempDown 

The GPIOx signal is used as input signal. At every positive edge (transition 
from logic 0 to logic 1) the target temperature is increased or decreased by 
the chosen step size. If the signal is logic 1 for longer than 1 s, the target tem-
perature is changed with increasing speed in the chosen direction (see chap-
ter 6.1.1 Buttons for more information). Pressing both buttons simultane-
ously for 6 seconds locks or unlocks the buttons. 

Pump The GPIOx signal is set to logic 1 to enable a pump. Use the "CHx Pump Con-
trol" settings to configure the behavior. 

Lookup Start The GPIOx signal is used as input signal. A positive edge starts, and a negative 
edge stops lookup table execution. 
By default, the table ID 0 is executed. The ID to be executed is a volatile set-
ting; it is possible to change it over the communication interface. 
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Function Name Description 

Dev Adr +1 
Dev Adr +2 
Dev Adr +4 

The GPIOx signal is used as input signal. For each pin which is logic 1 and with 
this function enabled, 1, 2 or 4 is added to the device address. This is only 
done once at startup. 

Fan Stop The GPIOx signal is used as input signal. If this function is enabled and the 
corresponding pin is 1, the fan is disabled. If the pin is 0 the fan runs normally. 

Alt Target Tx The GPIOx signal is used as input signal. This function allows to select up to 4 
different target temperatures, by changing the signal level of the pins. The 
value of parameter 3000 will be overwritten with these temperature values. 

CHx Alt Target T2 CHx Alt Target T1 Selected Target Temp 

0 0 "Temperature 0" from 
"GPIO Detail" options 

0 1 "Temperature 1" from 
"GPIO Detail" options 

1 0 "Temperature 2" from 
"GPIO Detail" options 

1 1 "Temperature 3" from 
"GPIO Detail" options 

 

PowerSt 0A The GPIOx signal is used as input signal. If the signal is 1, the output current 
for the corresponding channel is set to 0 A, without disabling or reinitializing 
the temperature controller. This can be useful for critical measurement cy-
cles. 

Encoder A 
Encoder B 

The GPIOx signal is used as input signal. A Rotary Encoder is to be connected 
to the Encoder A and Encoder B inputs. It can then be used to change the 
target temperature. 

Ramp The GPIOx signal is 1, when the corresponding channel is ramping to the tar-
get temperature. 

Fix 0 Just sets the output to fix 0. Can be inverted using the "Level Assignment". 

HW Enable Toggle The signal is used as an impulse to toggle the output between on and off. 

 

The Logic Level of each pin can be assigned under "Level Assignment" in the collapsed "GPIO General" 

options within the "I/O" window. For inputs, Logic Level Positive means that a high voltage is read in 

as logic 1 while a low voltage (Pin connected to GND) is logic 0. This can be inverted by setting the 

parameter to "Negative". For outputs, the logic level inverts the Signal when set to "Negative". This 

means that for example the "TEC OK" signal outputs 0V when the TEC is in "Ready" or "Run" status and 

the "Level Assignment" is set to "Negative". 

The pins can be individually configured under "Hardware Configuration" in the "I/O" window. When a 

signal is used as an input the hardware configuration must be made accordingly or the function will 

not be operational. The hardware configuration is described in Table 11.$ 
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Table 11: GPIO Pins Hardware Configuration 

Function Name Description 

IN WeakNo The GPIO Pin is configured as Input. No PullUp or PullDown Resistor is acti-
vated. 

IN WeakUp The GPIO Pin is configured as Input. A weak PullUp Resistor to 3.3V of approx-
imately 50kΩ is activated. 

IN WeakDown The GPIO Pin is configured as Input. A weak PullDown Resistor of approxi-
mately 50kΩ is activated. 

OUT PushPull The GPIO Pin is configured as Push Pull Output. No PullUp or PullDown Resis-
tor is activated. 

OUT OD NoPull The GPIO Pin is configured as an Open Drain Output. No PullUp or PullDown 
Resistor is activated. 

OUT OD WeakUp The GPIO Pin is configured as an Open Drain Output. A weak PullUp Resistor 
to 3.3V of approximately 50kΩ is activated. 

 

For input signals like buttons, it is usually easier to set the pin to "Negative" logic and "In Weak Up". 

This way the switch can be connected between the GPIO pin and GND. 

6.1.1 Buttons 

The target temperature can be changed through two buttons connected to the GPIO connector. 

• It is recommended to connect the buttons between the GND pin and another GPIOx pin and 

set the Hardware Configuration to "IN WeakUp" and use negative logic. 

• Pressing both buttons simultaneously for 6 seconds locks or unlocks the buttons. 

The Buttons can be configurated in the "I/O" window within the collapsed "GPIO Detail" options. See 

Table 12 for a description of the settings. 

Table 12: CHx Target Temperature Button Configuration 

Parameter Name Description 

Upper Temperature Limit 
Specifies the maximum Target Temperature which can be set 
by using the up button. 

Lower Temperature Limit 
Specifies the minimum Target Temperature which can be set 
by using the down button. 

Step Size Specifies the single step size, applied on every edge. 

 

6.1.2 Rotary Encoders 

The target temperatures can be changed by connecting a rotary encoder for each channel to the GPIOs. 

• It is recommended to connect the rotary encoder common connection to GND and the outputs 

to the GPIOx pins. 

• With continuous rotation the step size is automatically increased to facilitate large changes in 

the target temperature. 

• The direction of rotation in which the target temperature is increased or decreased can be 

changed by swapping output A with output B and vice versa. 

The "Step Size" and "Temperature Limit" settings from the "Channel x → Change Temperature But-

tons" box in the "GPIO Detail" section in the "I/O" window are used for the Rotary Encoders. 
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6.1.2.1 Encoder Recommendations 

Meerstetter Engineering has tested the following encoders which fulfill the above-mentioned require-

ments. 

Manufacturer P/N DigiKey P/N Resolution 

TT BI EN11-HSM1AF15 987-1188-ND 20 Pulses per Revolution 

Bourns PEC11R-4215F-N0024 PEC11R-4215F-N0024-ND 24 Pulses per Revolution 

Panasonic EVE-WRHJR012B P15917-ND 12 Pulses per Revolution 

 

6.1.3 Fan for Heatsink Cooling 

Up to two fans can be connected and controlled by the TEC Controller. The "Fan Control Feature" is 

intended to keep the heatsink temperature below a specified temperature, by using the slowest fan 

speed possible. Please refer to chapter 6.1 on how to configure the fan control signals. 

6.1.3.1 Fan Requirements 

The "Fan Control Feature" is only compatible to fans with the following features: 

• PWM control signal input to control the fan speed. The TEC Controller generates a 25 kHz or 1 

kHz PWM signal from 0 to 100%. 3.3 V voltage level. 

• Optional, but recommended: Frequency generator signal output which represents the rotation 

speed. The output should be an open collector output signal. 

For the logic level voltage definitions of the TEC Controllers, please refer to the datasheets. 

6.1.3.2 Fan Recommendations 

To obviate the need for a separate power supply, it is recommended to use a fan with the same supply 

voltage as the TEC Controller needs. 

We have tested the following fans, which fulfill the above-mentioned requirements. All fans stop (0 

rpm) at 0% PWM signal. 

Table 13: Fan recommendations 

Fan Manufacturer P/N DigiKey P/N Voltage [V] 
Power 
[W] 

Dimensions [mm] 

L H W 

1 FFB0424VHN-TZT4 603-1818-ND 24 2 40 40 28 

2 AFB0624EH-SP50 603-1803-ND 24 6 60 60 25 

3 PFB0824DHE-YDG 603-2028-ND 24 32 80 80 38 

4 AFB1224EHE-EP 603-1735-ND 24 20 120 120 38 

5 FFB0412VHN-TP03 603-1206-ND 12 2 40 40 28 

6 AFB0612DH-TP11 603-1211-ND 12 10 60 60 25 

7 EFC0812DB-F00 603-1159-ND 12 4 80 80 15 

8 FFC1212D-F00 603-1789-ND 12 17 120 120 25 

9 PF40281BX-000U-S99 259-1666-ND 12 11 40 40 28 
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6.1.3.3 Optimized Settings 

The following values are optimal settings for the Fan Speed Controller parameters of the TEC Controller 

in combination with the corresponding fan. The bypass option ("Bypassing Speed Controller") is used 

for fans with integrated speed controller, to disable the TEC Controller's speed controller. 

Fan 0% Speed [rpm] 100% Speed [rpm] Kp [%/rpm] Ti [s] Td [s] Bypass 

1 - - - - - Yes 

2 - - - - - Yes 

3 - - - - - Yes 

4 - - - - - Yes 

5 0 10000 0.005 0.5 0 No 

6 0 10000 0.005 0.5 0 No 

7 0 4200 0.005 0.5 0 No 

8 0 4400 0.005 0.5 0 No 

9 0 22500 - - - Yes 

 

6.1.3.4 Connecting the Fan to the TEC Controller 

• If the fan supports the same supply voltage as the TEC Controller, it is recommended to con-

nect the fan's GND and VCC to the TEC Controller's GND and VIN, respectively. 

• If a separate power supply is used for the fan, make sure that the two GND terminals of the 

power supplies are connected. Never leave the fan's GND unconnected when the fan is pow-

ered. Otherwise, the GPIOx pins may be destroyed. 

• Assign the correct function to the GPIO signals (see chapter 6.1 GPIO1 – GPIO10 Control Sig-

nals). 

• The PWM input of the fan must be connected to GPIO3 or GPIO4, since only these outputs 

generate a PWM signal. As an example, you can configure the GPIO as follows: 

o Pin: GPIO4 

o Function: Fan PWM 

o Level Assignment: Positive 

o Hardware Configuration: OUT PushPull 

• The frequency output signal of the fan can be connected to any of the GPIO signals. As an 

example, you can configure the GPIO as follows: 

o Pin: GPIO3 

o Function Fan Tacho 

o Level Assignment: Positive 

o Hardware Configuration: IN WeakUp 

  

https://www.meerstetter.ch/


TEC-Family User Manual 5216J (FW v6.00) Meerstetter Engineering GmbH 45 

6.1.3.5 Control Function 

The Fan Control feature uses two PID controllers. 

The first PID controller sets the required cooling power depending on the temperature of the heatsink. 

In most cases only P control is used. We recommend a value of 30 %/°C for Kp. Thus, for a target 

temperature of 40 °C the fan will rotate with 0% speed at 40 °C and 90% speed at 43 °C. 

This required cooling power is then converted into a nominal fan speed. For example, if the minimum 

and maximum fan speeds are set to 1000 rpm and 11000 rpm, respectively, the required cooling power 

of 50% is converted into a nominal fan speed of 6000 rpm. 

The second PID controller sets the fan speed by varying the PWM output signal until the nominal fan 

speed is reached. 

The "Fan Speed Controller" should be set up before without temperature regulation of the heatsink. 

This can be done by setting both the "Target Temperature" and the "100% Speed" to a high value. This 

allows to use the "0% Speed" as a fixed rotation speed. The fan should reach the nominal speed as fast 

as possible. 

It is possible to stop the fan by an external GPIOx signal. This is useful, e.g., if a door of a compartment 

is opened (see chapter 6.1 GPIO1 – GPIO10 Control Signals). 

If a hysteresis is needed the parameters "Min Speed Start" and "Min Speed Stop" can be used. If those 

values are set to zero, they will be ignored. 
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6.1.3.6 Fan Parameter Description 

Table 14: CHx Fan Control Enable 

Parameter Name Options and Description 

Fan Control Enable • Disabled 

• Enabled: Enables the fan controller 

 

Table 15: CHx Fan Temperature Controller 

Parameter Name Options and Description 

Fan Temperature Source The Actual Temperature for the temperature controller is taken 
from: 

• HR 1: High Resolution Measurement Input 1 

• HR 2: High Resolution Measurement Input 2 

• LR 1 Low Resolution Measurement Input 1 

• LR 2: Low Resolution Measurement Input 2 

• LR 3: Low Resolution Measurement Input 3 

• LR 4: Low Resolution Measurement Input 4 

• Device: Device temperature of the TEC Controller 
 
The assignment of the temperature source can be done in the 
main window in the following popups that lead to the "Fan Con-
troller x" buttons: 

 
Target Temperature Target temperature (set point) for the temperature controller 

Kp, Ti, Td PID controller parameters for the temperature controller 

 

Table 16: CHx Fan Temperature Controller 

Parameter Name Options and Description 

0% Speed Minimum rotation speed 

100% Speed Maximum rotation speed 

Min Speed Start Minimal speed above which the fan is started 

Min Speed Stop Minimal speed below which the fan is stopped 

Kp, Ti, Td PID controller parameters for the Fan Speed Controller 

Bypassing Speed Controller • Yes: Disables the Fan Speed Controller. The "Relative Cooling 
Power" is written directly to the PWM output. 

• No: The built-in speed controller is used. 

Fan Surveillance Disables Error 175 (ERROR_FAN_CONTROL_LIMIT) and Error 176 
(ERROR_FAN_BLOCKED) 
This can be used when no tachometer signal is available. 
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6.2 Display Kits 

Our optional OLED display kits (DPY-1113, DPY-1114 and DPY-1115), which feature either two lines 

with 16 chars or four lines with 20 chars, can be attached to our TEC Controllers out of the box. In case 

of the TEC-1092, the display kits can only be used in combination with the EVL-1093 evaluation board. 

 

Figure 21: A DPY-1113 connected to a TEC-1089 TEC Controller, displaying the object temperature and the output current. 

You must enable the respective display type and select the information to be displayed in the "Display" 

window of the TEC Configuration Software. 

The TEC Controller must be reset before the Display becomes active. 

Table 17: General Display Settings 

Setting Options Description 

Display Type 

OFF Disables the display feature 

OLED 2x16 (DPY-1113) For display: DPY-1113 

OLED 4x20 (DPY-1114) For display: DPY-1114 

Small OLED 2x16 (DPY-1115) For display: DPY-1115 

Line 1 - 4  
Default Text 

Various 
(see description below) 

Defines the text to be displayed on the 
corresponding line. 

Line 1 – 4  
Alternative Text 

Various 
(see description below) 

Defines the text to be displayed for the al-
ternative mode. 

Line 1 – 4  
Startup Text 

Various 
(see description below) 

Defines the text to be displayed at the 
startup of the controller. 

Line 1 – 4  
Alternative Mode 

None No alternative information is displayed. 

On Error 
If the TEC Controller is in Error state, the 
alternative information is being displayed. 

Toggle on Error 
If the TEC Controller is in Error state, the 
alternative information is being toggled 
with the default information. 

Toggle 
The default information is toggled with 
the alternative information. 

 

  

https://www.meerstetter.ch/


TEC-Family User Manual 5216J (FW v6.00) Meerstetter Engineering GmbH 48 

6.2.1 Display Text 

The Display can be used to show fully user-configurable text including all accessible parameters. 

Text consisting of standard characters will just be shown as is on the display. To incorporate parame-

ters please follow the syntax described below. Multiple parameters can be displayed on a single line, 

the only limit is the numbers of characters of the display.  

6.2.1.1 Displaying System Parameters 

The syntax for the "Display Format Argument String" is as follows: 

User Text: {Parameter Syntax} Other User Text 

• User Text: Text defined by the user. Will be displayed as is. 

• {Parameter Syntax}: System Parameter according to the syntax description below. 

• Other User Text: Text defined by the user. Will be displayed as is.  

Text and System Parameters can be displayed in any order and in any number, which enables the dis-

playing of a vast variety of information. 

User Text 1{Parameter Syntax}User Text 2{Parameter Syntax}{Parameter Syntax}User Text 
3 

6.2.1.2 Parameter Syntax 

{Parameter ID;Parameter Instance;Fractional Points;Number of Digits;Argument 
Type;Argument ID} 

Field Value Range Description 

Parameter ID 0 – 65535 Parameter ID as described in the "TEC Controller 
Communication Protocol 5136" document. 

Parameter Instance 1 – 255 Parameter Instance as described in the "TEC Con-
troller Communication Protocol 5136" document. 

Usually, Instance 1 is TEC CH1 and 

Instance 2 is TEC CH2. 

Fractional Points 0 – 6 Number of digits shown after the decimal point. 

Number of Digits 0 – 13 Number of total digits shown. 

Argument Type 0 – 1 Optional argument type 
1 = Temp Format 

Argument ID Char Optional argument ID 
Temp Format (1): 

C = Celsius (Default) 

F = Fahrenheit 

K = Kelvin 

 

https://www.meerstetter.ch/


TEC-Family User Manual 5216J (FW v6.00) Meerstetter Engineering GmbH 49 

6.2.1.3 Examples 

To further clarify let's take apart an example display text: 

Object:{1000;1;2;5}°C 

Object:  Text defined by user. The Display will show "Object". 

{1000;1;2;5} TEC Controller Parameter ID. Refer to section "Parameter Syntax". Display will show 

"23.12" (23.12°C is the Object Temperature measured by the controller). 

°C Text defined by user. The Display will show "°C". 

To get a better understanding of how to set display text here are some examples: 

Text Text Shown on Display Description 

Object: {1000;1;2;5}°C Object: 23.12°C Channel 1 Object Tempera-
ture 

Sink: {1001;1;1;4}°C Sink: 25.1°C Channel 1 Sink Temperature 

Current: {1020;1;2;4}A Current: 1.22A Channel 1 Actual Output Cur-
rent 

Voltage: {1021;2;2;5}A Voltage: 4.23V Channel 2 Actual Output Volt-
age 

Target: {3000;1;2;5}°C Target: 15.00°C Channel 1 Target Tempera-
ture 

Target: {3000;2;1;4}°C Target: 20.0°C Channel 2 Target Tempera-
ture 

Status: {104;1;0;2} Status: 2 TEC Controller Status 

Stat: {104;1;0;2} Err: {105;1;0;2} Stat: 1 Err: 0 TEC Controller Status and Er-
ror Number 

 

The following configuration will show the object temperature of both channels and the output current 

and output voltage of both channels: 

Table 18: Default Text Examples 

Parameter Text 

Default Text 1 CH1 Temp: {1000;1;3;8}°C 

Default Text 2 CH2 Temp: {1000;2;3;8}°C 

Default Text 3 CH1: {1020;1;1;6}A {1021;1;1;6}V 

Default Text 4 CH1: {1020;2;1;6}A {1021;2;1;6}V 
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Figure 22: DPY-1114 Display (4x20 Characters) example. 

6.2.1.4 Displaying Error Messages and Information 

The TEC Controller can display an error description if needed. To do this, use the syntax described 

below: 

{ERRMSG} A short error message is displayed. If there is no error, the TEC-Controller status is 

shown. 

{ERRINF} Error information is displayed in the following way: 

"Err: Error Number.Error Instance.Error Parameter". 

If no error is currently present 0 is being displayed as error information. 
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7 Special Functions 

7.1 Lookup Table Processing & Scripting 

TEC Controllers can store and executing temperature profiles with predefined curves, ramps, slopes 

and hold times. These temperature profiles are defined with a script language.  

Processing of lookup tables (LUT) is controllable over remote control. The MeCom communication pro-

tocol allows sub-table selection, choosing the number of repetitions, starting, and stopping the pro-

cessing and reading status information. LUT processing can also be started over hardware GPIOx sig-

nals using the "Lookup Start" GPIO function. 

7.1.1 Lookup Table Control from within the TEC Configuration Software 

LUT processing is accessible in the Configuration Software in the "Lookup Table" window. Make sure 

that prior to using the lookup table processing, the TEC Controller is well tuned. 

• Click "Load CSV File" to choose a LUT and save it to the controller's memory by clicking on 

"Download". 

• For each TEC Controller channel, select the table ID and the number of executions. 

• Click "Start" to enable processing of the table. 

• While processing LUTs, the TEC Controller will ignore any other temperature settings, i.e., in 

the "Temperature Controller" window. 

• Once all instructions of the LUT have been executed or when LUT control is cancelled, the 

channel of the TEC Controller returns to its previous state. 

7.1.2 Instruction Set and Options 

One single LUT instruction is defined as line with three elements, separated by semicolons: 

Instruction; Field1; Field2 

The second and third elements (Field1 and Field2) are not always used. However, make sure that the 

semicolons between the elements are still present on the lines of the lookup table as the lookup table 

file cannot be processed without these delimiters. 

E.g., when using the "TILL_TEMP_STABLE" instruction write the following line: 

TILL_TEMP_STABLE;; 

Please note that the maximum number of instructions possible in a lookup table is 8192 instructions. 

7.1.2.1 Table of Instructions 

Type Symbol Name / Range Description 

Instruction  TABLE_INFO Start and End Markers of a defined portion (Sub 
Table) of the loaded Lookup Table. 
Table ID is selectable from within the TEC Config-
uration Software in the "Lookup Table" window. 

Field 1 Option START Start of Sub Table 

Field 1 Option END End of Sub Table 

Field 2 Value Range 0+INT32 Table ID (arbitrary identification number, set by 
user) 
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Type Symbol Name / Range Description 

Instruction  SIN_RAMP_TO Standard Sine Ramp 

Field 1 Option FROM_ACT Ramp from Actual Object Temperature 

Field 1 Option FROM_NOM Ramp from Latest Target Temperature 

Field 2 Value Range FLOAT32 Target Temperature in °C 

Instruction  REPEAT_MARK Repetition Markers. The instructions between 
START and END will be repeated a predefined 
number of times. 
The Number of Executions is selectable from 
within the TEC Configuration Software in the 
"Lookup Table" window. 

Field 1 Option START Start of Repetition Field 

Field 1 Option END End of Repetition Field 

Instruction  LIN_RAMP_TIME Linear Ramp between the Current Target Tem-
perature to the New Target Temperature. 
Important: Make sure you use at least one 
"SIN_RAMP_TO / FROM_ACT" to have a defined 
behaviour from the current temperature to your 
first target Temperature.  

Field 1 Value Range UINT24 Ramp Time in ms (1000 = 1 second) 
Resolution 100ms 

Field 2 Value Range FLOAT32 New Target Temperature in °C 

Instruction  STATUS Instruction at the End of a Table 

Field 1 Option DISABLE Disables the TEC Channel 

Field 1 Option ENABLE Enables the TEC Channel 

Instruction  EOF End of File mark (must always be present as last 
instruction in the lookup table file) 

Field 2 Value CRC The CRC is calculated and inserted by the TEC 
Configuration Software 

Instruction  WAIT Wait Instruction 

Field 1 Option FOREVER Waits here forever (until the system is switched 
off or the Sub Table execution is cancelled) 

Field 1 Option TIME Waits the time defined in Field 2 

Field 2 Value Range 0+INT32 Specifies the Wait Time in ms (only if Field 1 Op-
tion is TIME) 

Instruction  SET_FLOAT Set ME Parameter ID (see TEC Communicaton 
Protocol document) 

Field 1 Value Range UINT24 meParameter Number 

Field 2 Value Range FLOAT32 New Float Value 

Instruction  SET_INT Set ME Parameter ID (see TEC Communicaton 
Protocol document) 

Field 1 Value Range UINT24 meParameter Number 

Field 2 Value Range INT32 New Integer Value 

Instruction  TILL_TEMP_STABLE Wait until Temperature is stable 

Instruction SET_TARGET_INST Change the Instance, which the Instructions 
should affect 

Field 1 Value Range UINT24 Not used. Write 0. 

Field 2 Value Range INT32 Instance Number 
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7.1.2.2 Value Range Definitions 

Range Name Description 

0+INT32 0 … 2147483647 

FLOAT32 32-bit Float according to IEEE754 

UINT24 0 … 16777215 

INT32 32-bit Signed Integer 

 

7.1.3 Lookup Table Examples 

Included with the "TEC-Family TEC Controllers Software Package" you will find two files with lookup 

table examples. If installed, click on the TEC Software "Additionals"-Shortcut on your desktop. In this 

folder you can find the "Lookup-Table Dok" subfolder, which contains the two lookup table examples. 

The CSV files can be directly loaded onto a TEC Controller and the XLS files with the same names con-

tain the same lookup table contents as the CSV files, but with explanations in the last column about 

what the used instructions do. 

7.2 Advanced Misc Settings 

7.2.1 Power Stage Overtemperature Behavior 

The behavior of the firmware depends on the device temperature of the TEC Controller, which is reg-

ularly measured. Refer to the datasheet of the corresponding TEC Controller for more information 

about the current to temperature relationship. 

The temperature behavior can be changed in the "View → Advanced Misc Settings" window via the 

menu bar of the main window. 

Table 19: Device Temperature Mode (Output Stage) 

Option Description 

Standard Fixed error temperature limits are applied. If the device temperature reaches the 
limit, the OVERTEMPERATURE error is thrown. 

Extended The extended temperature range is enabled. Depending on the device temperature 
the current is being limited. You can find the corresponding limit curves in our TEC 
Controller Datasheets.  

 

7.2.2 Error State Auto Reset Delay 

If the system is in the error state, it restarts after a specified time. This feature is disabled if a time of 

0 seconds is specified in the "Delay until Reset" parameter. The auto reset is delayed for a fixed time 

of 20 seconds after starting up. 

7.2.3 Error 108 Delay 

Error 108 occurs when Output Stage is in saturation for more than 1ms. It usually occurs when the 

controller wants to increase the output voltage but is unable to do so because the input voltage is too 

low. It can also occur in situations where it is unavoidable based on the system setup around the TEC 

Controller, which is why it is possible to adjust the conditions of this error or fully disable it if necessary. 

By adjusting the time of the "Error Delay [CHx]" parameter the saturation error condition can be ad-

justed and by setting the parameter value to "-1" it will be completely disabled. 
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8 Appendix 

8.1 Troubleshooting 

Table 20: Typical Problems 

Problems Possible Reason Possible Solution 

The TEC Configuration Soft-
ware is not starting 

The required .NET Desktop 
Runtime is not installed on the 
system. 

Make sure that you have the 
.NET Desktop Runtime in-
stalled on your system. See 
Download .NET (mi-
crosoft.com). 

I want to use a NTC10K sensor. 
Is it compatible with a NTC18K 
(or NTC39K, NTC56K, NTC1M) 
configuration? 

 Yes. See chapter 3.1.1.1 Exa-
mple NTC Configuration for a 
detailed description. 

The output is suddenly 
switched off 

The "Upper and Lower Thresh-
old" aren't set correctly. 

Check the error message. 
Make sure that the "Upper 
Threshold" and "Lower Thresh-
old" are set correctly in the 
"HR Input x" window. 

The Peltier element is heating 
instead of cooling 

The Peltier element is con-
nected the wrong way. 

Switch the wires of the Peltier 
element at the connector of 
the TEC Controller. 
Or switch "Positive current is" 
from heating to cooling in the 
"Temperature Controller" win-
dow. 

The parasitic heat generated in 
the Peltier module can no 
longer be dissipated. 

Reduce the current and/or im-
prove the cooling of the 
heatsink. 

The firmware is too old The firmware of the TEC Con-
troller is too old to connect to 
the TEC Configuration Soft-
ware. 

Please update the firmware as 
described in chapter 2.5 Firm-
ware Updates. 

The temperature stability is 
worse than expected 

There are several reasons, 
here are the most important 
ones: interference (tempera-
ture, electrical) temperature 
sensors are placed wrong. 

To achieve a stabile object 
temperature, the cold side and 
the object must be insulated 
from the environment. 
Check position and behavior of 
the temperature sensors. 

CHx Output Stage Controller 
Limit (Error 108) 

This usually happens if the TEC 
Controller's input voltage is 
too low for the desired output 
voltage. 

Use power supply with suffi-
cient output current and volt-
age. 

As a first measure, you may re-
duce the "Current Limitation" 
value in the "Temperature 
Controller" window.  

TEC Controller can supply volt-
age but current is always close 
to 0 and there is no error 
shown 

In most cases the Peltier ele-
ment is defective. 

Try swapping the Peltier ele-
ment to see whether the prob-
lem persists. 
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8.2 Error Numbers, Instances and Parameters 

• Error Numbers from 1 through 99 designate error conditions that are universal across the 
whole range of Meerstetter advanced TEC Controllers and laser diode drivers. 
Error numbers starting from 100 designate conditions that are specific to TEC-Family devices 
(see tables below). 

• Error Instance typically designates the channel involved. For single-channel devices like the 
TEC-1091 it is 1. For two-channel devices like the TEC-1161, it can be 1 or 2. 

• Error Parameters are additional information helping the software engineers at Meerstetter 
Engineering in the processes of error diagnosis or remote debugging. 

 

8.2.1 Error Numbers 1 - 99 (Universal) 

Table 21: Processor Errors 

# Description Error Condition Further Information 

1–10 
13–15 

MCU system malfunction - Processor internal failure.  
 
If a reset or power cycle 
does not fix the issue, 
please contact the manu-
facturer. 

 

Table 22: HMI Errors 

# Description Error Condition Further Information 

11 Emergency stop was trig-
gered by LTR-1200 

- Confirm whether you oper-
ate the LTR-1200 and the 
devices it contains within 
their specified limitations. 

12 LTR-1200 HMI regularly 
sends 'free' signals to all 
rack-internal devices such 
that they can activate their 
output stages (if enabled) 

No signal received for more 
than one second 

- 

 

Table 23: Parameter System Errors 

# Description Error Condition Further Information 

20–21 Internal parameter system 
malfunction 

Error occurs during reading 
or writing a parameter 

Most likely a bug in the 
firmware, check if there is a 
new firmware version avail-
able or contact the manu-
facturer. It is also possible 
that the flash is defect. 

22 Parameter set corrupt Configuration flash empty 
or defect. 

Load .xml file saved prior to 
FW update, or Default.xml 

23 Parameter set incompatible 
with current firmware ver-
sion 

- Load .xml file saved prior to 
FW update, or Default.xml 
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# Description Error Condition Further Information 

24 Firmware does not recog-
nize valid device 

Unknown device type, set 
the right device type (only 
possible by the manufac-
turer) 

Contact the technical sup-
port of the manufacturer to 
resolve the issue. 

25 Internal parameter system 
malfunction 

Access to a non-existing in-
stance 

Most likely a bug in the 
firmware, check if there is a 
new firmware version avail-
able or contact the manu-
facturer. 

26 Internal meta data system 
malfunction 

- Most likely a bug in the 
firmware, check if there is a 
new firmware version avail-
able or contact the manu-
facturer. 

27 Parameter write or read 
wrong datatype function 
used 

- Will be thrown when trying 
to read or write the wrong 
datatype value from/to a 
parameter (e.g., when try-
ing to get a floating-point 
value from an integer pa-
rameter). 

28 Parameter write value out 
of range 

- Will be thrown when trying 
to write a value to a param-
eter that is out of its limits 
(e.g., when trying to write 
an integer number that is 
larger than the maximum a 
32-bit integer can hold). 

29 Parameter save to flash 
called from interrupt 

- Writing to flash from the In-
terrupt Service Routine 
(ISR) is not allowed and 
when attempted will result 
in this error. 

 

Table 24: Power Supply Errors 

# Description Error Condition Further Information 

30 Input voltage net too low < 10.5V for TEC-
1089/1090/1122/1123/ 
1162/1163/1166/1167 

Input voltage from the 
power supply is too low or 
unstable. 
Try increasing the supplied 
voltage to the controller. 
Please take care not to ex-
ceed the maximum input 
voltage of the device to 
avoid damaging the device. 
Also try limiting the number 
of devices on the same 
power supply or try swap-
ping the power supply. 

< 4.8V for TEC-
1092/1091/1161 
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# Description Error Condition Further Information 

31 Input voltage net too high > 27.0V for -SV Types Input voltage from the 
power supply is too high or 
unstable. 
Try decreasing the supplied 
voltage to the controller. 

> 38.0V for -HV Types 

> 14.0V for TEC-1092 

> 25.5V for TEC-1091/1161 

> 64.0V for TEC-
1162/1163/1166/1167 

32 Internal Medium Voltage 
power net too low 

< 8.0V (HW Version De-
pending) 

≥ HW v1.51 for TEC-
1089/1090 
≥ HW v1.32 for TEC-
1122/1123 

May be related to the 
power supply and its set-
tings. Can be thrown while 
powering on the controller 
when the supplied voltage 
is not immediately guaran-
teed. Try changing the 
power supply settings or try 
swapping out the power 
supply. 
If the measured value is 
constantly below the mini-
mum (see "Medium Inter-
nal Supply" value in the 
"System" window), then it 
is very likely the controller 
is damaged. 

< 4.7V for TEC-
1092/1091/1161/ 
1162/1163/1166/1167 

33 Internal Medium Voltage 
power net too high 

> 9V (HW Version Depend-
ing) 

≥ HW v1.51 for TEC-
1089/1090 
≥ HW v1.32 for TEC-
1122/1123 

May be related to the 
power supply and its set-
tings. Can be thrown while 
powering on the controller 
when the supplied voltage 
is set too high. Try changing 
the power supply settings 
or try swapping out the 
power supply. 
If the measured value is 
constantly above the maxi-
mum (see "Medium Inter-
nal Supply" value in the 
"System" window), then it 
is very likely the controller 
is damaged. 

> 5.25V for TEC-
1092/1091/1161/ 
1162/1163/1166/1167 
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# Description Error Condition Further Information 

36 Internal 3.3V power net too 
low 

< 3.1V May be related to the 
power supply and its set-
tings. Try changing the 
power supply settings or try 
swapping out the power 
supply. 
If the measured value is 
constantly below the mini-
mum value (see "3.3V Inter-
nal Supply" value in the 
"System" window), then it 
is very likely the controller 
is damaged. 

37 Internal 3.3V power net too 
high 

> 3.5V May be related to the 
power supply and its set-
tings. Try changing the 
power supply settings or try 
swapping out the power 
supply. 
If the measured value is 
constantly above the maxi-
mum value (see "3.3V Inter-
nal Supply" value in the 
"System" window), then it 
is very likely the controller 
is damaged. 

 

Table 25: Flash Memory Errors 

# Description Error Condition Further Information 

50 On-board flash failure Write Timeout Can happen when the write 
cycle limit of the flash (>= 
100'000) is hit. It will not be 
possible to persist any new 
values on the flash once the 
limit has been hit. 

51 On-board flash failure Erase Timeout Can happen when the write 
cycle limit of the flash (>= 
100'000) is hit. It will not be 
possible to persist any new 
values on the flash once the 
limit has been hit. 

52 On-board flash failure Invalid Address Can happen a value is tried 
to be written to an invalid 
or reserved address space 
on the flash. 
Is most likely a bug in the 
firmware, check if there is a 
new firmware version avail-
able or contact the manu-
facturer. 
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Table 26: Communication Error 

# Description Error Condition Further Information 

53 UART Send buffer overflow 
error 

An overflow occurred while 
trying to write a character 
to the Tx send buffer. 

Is most likely a bug in the 
firmware, check if there is a 
new firmware version avail-
able or contact the manu-
facturer. 

54 CANopen internal error - Internal error by the CANo-
pen library. The CANopen 
error code is returned as Er-
ror Parameter. 

 

Table 27: Device Temperature and Hardware Errors 

# Description Error Condition Further Information 

60 Device running too hot Check the datasheet of your 
device for the maximum de-
vice temperature specifica-
tion. 

Try to cool your device, e.g., 
by adding active cooling in 
the form of a fan or passive 
cooling using a heat sink. 

61 Communication error with 
I/O hardware during factory 
test 

- This error can only happen 
during the internal hard-
ware test performed by the 
manufacturer. 

63 UART Temperature Sensor 
malfunction. 

Cannot initialize the Device 
Temperature sensors or 
they deliver wrong values. 

Is most likely a bug in the 
firmware, check if there is a 
new firmware version avail-
able or contact the manu-
facturer. 
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8.2.2 Error Numbers 100 - … (Specific for TEC-Family devices) 

Table 28: Power Output Errors 

# Description Error Condition Further Information 

100 Overcurrent (positive), 
Driver CHx OUT+ 

> 'Current Error Threshold' Check whether the actual 
output current is higher 
than the defined "Output 
Current Error Threshold" in 
the "Temperature Control-
ler" window. 

101 Overcurrent (negative), 
Driver CHx OUT+ 

> 'Current Error Threshold' Check whether the actual 
output current is higher 
than the defined "Output 
Current Error Threshold" in 
the "Temperature Control-
ler" window. 

102 Overcurrent (positive), 
Driver CHx OUT- 

> 'Current Error Threshold' Check whether the actual 
output current is higher 
than the defined "Output 
Current Error Threshold" in 
the "Temperature Control-
ler" window. 

103 Overcurrent (negative), 
Driver CHx OUT- 

> 'Current Error Threshold' Check whether the actual 
output current is higher 
than the defined "Output 
Current Error Threshold" in 
the "Temperature Control-
ler" window. 

104 Overvoltage, Driver CHx 
OUT+ 

> 'Voltage Error Threshold' Check whether the actual 
output voltage is higher 
than the defined "Output 
Voltage Error Threshold" in 
the "Temperature Control-
ler" window. 

105 Overvoltage, Driver CHx 
OUT- 

> 'Voltage Error Threshold' Check whether the actual 
output voltage is higher 
than the defined "Output 
Voltage Error Threshold" in 
the "Temperature Control-
ler" window. 

106 Residual current too high. 
The Current difference be-
tween OUT+ and OUT- is 
too big. 

|OUT+ - OUT-| > Imax *0.1 An isolation failure has 
been found. 
Check if there is a connec-
tion between OUT+ and 
OUT- to something else 
(e.g., ground) than your 
Peltier element or resistive 
heater. 

107 Overall current monitoring, 
triggers fast switch off 
(within 10 μs) 

Approximately 150% of the 
nominal maximal output 
current.  

Check if there is a short cir-
cuit between OUT+ and 
OUT- or whether there is a 
short circuit on the Peltier 
element. 
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# Description Error Condition Further Information 

108 Output Stage saturation er-
ror. 
Check input current is suffi-
cient and Vout not set too 
close to Vin. Try to reduce 
the "Current Limitation" in 
the "Operation" tab. 

Output Stage is in satura-
tion for more than 1ms. 
This time can be changed 
by a user setting. 

Usually occurs when the 
controller wants to in-
crease the output voltage 
but is unable to do so be-
cause the input voltage is 
too low. This can happen, 
among other things, if the 
output voltage limit ("Out-
put Voltage Limitation") is 
set too close to the effec-
tive input voltage. Ideally, 
there would be a margin of 
4 V, but less is usually also 
possible. 

109 In case of parallel opera-
tion: The output current 
from channel 1 and channel 
2 are too unequal. 

If an unequal current is 
measured, the power stage 
tries to balance the cur-
rents. If this is not success-
ful after some time, then it 
throws this error.  

Make sure CH1 and CH2 
are connected together 
with a Y-cable. 

111 The connected load has a 
too low resistance in com-
parison to the input voltage 

> 2/3*Imax before a stage 
goes fix to GND one 1 side. 
 

Try increasing the load re-
sistance. Reduce the input 
voltage and limit the cur-
rent to 2/3*Imax. 

 

Table 29: Current Measurement Errors 

# Description Error Condition Further Information 

120 Offset during initialization 
of current monitor too high, 
Driver CHx OUT+ 

> (Maximum Output Cur-
rent of the Controller / 16) 

- 

121 Offset during initialization 
of current monitor too low, 
Driver CHx OUT+ 

< -(Maximum Output Cur-
rent of the Controller / 16) 

- 

122 Offset during initialization 
of current monitor too high, 
Driver CHx OUT- 

> (Maximum Output Cur-
rent of the Controller / 16) 

- 

123 Offset during initialization 
of current monitor too low, 
Driver CHx OUT- 

< -(Maximum Output Cur-
rent of the Controller / 16) 

- 
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Table 30: HR Temperature Measurement Errors 

 

  

# Description Error Condition Further Information 

130 HR Temperature Measure-
ment Circuit Initialization 
failure 

Wrong detected ready sig-
nal. 

If this error occurs, it is very 
likely that an ADC on the 
controller is defective. If the 
error does not disappear af-
ter a reset/power cycle, 
please perform an ADC Self 
Check and send the results 
to the manufacturer for fur-
ther instructions. 

131 HR Temperature Measure-
ment Circuit failure 

Configuration read back 
failed. 

If this error occurs, it is very 
likely that an ADC on the 
controller is defective. If the 
error does not disappear af-
ter a reset/power cycle, 
please perform an ADC Self 
Check and send the results 
to the manufacturer for fur-
ther instructions. 

132 External ADC supply voltage 
out of range 

-5% < AVDD < +5% If this error occurs, it is very 
likely that an ADC on the 
controller is defective. If the 
error does not disappear af-
ter a reset/power cycle, 
please perform an ADC Self 
Check and send the results 
to the manufacturer for fur-
ther instructions. 

133 23bit ADC raw value below 
safety margin 

< 500000 (6%) Check if there is a short cir-
cuit in the temperature 
measurement wiring (HR). 
If this input is not used set 
the "ADC Limit Errors" and 
"Temp. Limit Errors" param-
eters in the "HR Input x" 
window both to "None". 

134 23bit ADC raw value above 
safety margin or the meas-
ured resistance is too high 

ADC > 8350000 (99.5%) 
R > 1MOhm 

Check if there is an open 
circuit in the temperature 
measurement wiring (HR). 
If this input is not used set 
the "ADC Limit Errors" and 
"Temp. Limit Errors" param-
eters in the "HR Input x" 
window both to "None". 

137 Measured HR temperature 
out of permitted range 

< 'Lower Error Threshold' Check if the measured HR 
temperature is smaller than 
"Lower Threshold" in the 
"HR Input x" window. 
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138 Measured HR temperature 
out of permitted range 

> 'Upper Error Threshold' Check if the measured HR 
temperature is higher than 
"Upper Threshold" in the 
"HR Input x" window. 

139 Change in measured HR 
temperature too fast (out-
pacing thermal inertia) 

> 'Max Change' while 20 
succeeding cycles into the 
same direction. 

Measured HR temperature 
changes too fast. 
 
Check if the measured ob-
ject temperature changes 
faster than the "Max 
Change" in the "HR Input x" 
window. 

150 HR Temperature Measure-
ment Circuit failure 
(23bit ADC new ADC value 
timing error) 

Ready signal is out of syn-
chronization 

Either the ADC is defective, 
or it is impaired in some 
way. 
Contact the manufacturer 
to open a new RMA case for 
your device if you wish to 
get it repaired. 

151 HR Temperature Measure-
ment Circuit failure 

Several times the same ADC 
value read 

This error usually occurs 
when the temperature sen-
sor is not properly con-
nected, or no sensor is con-
nected whatsoever. 
Verify the wiring of your 
sensor with the datasheet 
of your controller. 

152 HR Temperature Measure-
ment Circuit failure 

ADC Self Check failed. IRs 
out of range 

Can only occur while per-
forming an ADC Self Check 
and indicates damage on 
the ADC. 

153 HR Temperature Measure-
ment Circuit failure 

ADC Self Check failed. VRef 
out of range 

Can only occur while per-
forming an ADC Self Check 
and indicates damage on 
the ADC. 
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Table 31: LR Temperature Measurement Errors 

# Description Error Condition Further Information 

140 12bit ADC raw value below 
safety margin 

< 40 (1%) Check if there is a short cir-
cuit in the LR temperature 
measurement wiring. 
If the LR measurement 
should not be used set the 
option "Sink Source Selec-
tion" in the respective 
channel configuration 
popup on the main window 
to "Fixed" and set the "ADC 
Limit Errors" and "Temp. 
Limit Errors" parameters in 
the "LR Input x" window 
both to "None". 

141 12bit ADC raw value above 
safety margin 

> 4050 (99%) Check if there is an open 
circuit (e.g., when no sensor 
is connected) in the LR tem-
perature measurement wir-
ing. 
If the LR measurement 
should not be used set the 
option "Sink Source Selec-
tion" in the respective 
channel configuration 
popup on the main window 
to "Fixed" and set the "ADC 
Limit Errors" and "Temp. 
Limit Errors" parameters in 
the "LR Input x" window 
both to "None". 

142 Measured LR temperature 
too low 

< 'Lower Error Threshold' Check if the measured LR 
temperature is smaller than 
"Lower Threshold" in the 
"LR Input x" window. 

143 Measured LR temperature 
too high 

> 'Upper Error Threshold' Check if the measured LR 
temperature is higher than 
"'Upper Threshold" in the 
"LR Input x" window. 

144 Change in measured LR 
temperature too fast (out-
pacing thermal inertia) 

> 'Max Temp Change' while 
20 succeeding cycles into 
the same direction. 

Check if the measured LR 
temperature changes faster 
than the "Max Change" in 
the "LR Input x" window. 
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Table 32: Autotune Errors 

# Description Error Condition Further Information 

170 Auto Tune Progress Error Less than 3% of progress 
advancement in 5 minutes 
for the fast model and 60 
minutes for the slow model 

The progress of the auto 
tuning is determined upon 
several parameters. This er-
ror is generated when the 
process is too slow. 
 
Set the "Thermal Model 
Speed" to "Slow Model" to 
have longer time periods. 
 
Make sure your thermal 
model is stable before you 
start a new try. 

171 Auto tuning failures at 
three consecutive attempts 

More than 40% discrepancy 
in temperature 

The tuning process exe-
cutes several swing periods 
to determinate the results. 
This error is generated if 
values of these swing peri-
ods are too different. 
Do not change the thermal 
load during the tuning pro-
cess. 
Make sure the thermal ob-
ject is isolated from any 
changing air flows. 

172 Auto tuning failures at 
three consecutive attempts 

More than 40% discrepancy 
in waveform period 

The tuning process exe-
cutes several swing periods 
to determinate the results. 
This error is generated if 
values of these swing peri-
ods are too different. 
Do not change the thermal 
load during the tuning pro-
cess. 
Make sure the thermal ob-
ject is isolated from any 
changing air flows. 

173 The Temperature Controller 
is in its limitation or is not 
running.  

Make sure the Temperature 
Controller is Running and 
the Temperature has equal-
ized before you start the 
Auto Tuning 

Make sure that the TEC 
Controller's output stage is 
set to "ON", and that the 
TEC Controller's "Output 
Stage Input Selection" is set 
to "Temperature Control-
ler". 
Make sure you use suitable 
default PID Settings. 
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Table 33: Fan Control Errors 

 

Table 34: Lookup Table Errors 

# Description Error Condition Further Information 

180 Unknown Instruction - An instruction that is not 
supported by the firmware 
was found in the lookup ta-
ble. 
See chapter 7.1.2 Instruc-
tion Set and Options for a 
list of available instructions. 

181 Misuse of an Instruction - Check whether the Instruc-
tions used in your lookup 
table are in the correct or-
der and whether the Field 
options you use are com-
patible with their respective 
Instructions. 

 

  

# Description Error Condition Further Information 

175 The Fan does not reach the 
desired rotation speed. 

Fan PWM Signal is 100% 
and the reached Speed is < 
60% of the nominal speed 
while 12s 

Check if your Fan can reach 
the defined "100% Speed 
[rpm]" in the "Fan" window. 
If not, reduce the "100% 
Speed [rpm]" to a value, 
which your Fan can reach. 
 
Confirm whether the Fan 
might be broken. 

176 The Fan does not rotate Fan Speed = 0 and PWM 
Level > 35% while 10s 

Check if the Fan wiring and 
GPIO configuration of the 
TEC Controller are correct. 
 
Confirm whether the Fan 
might be blocked or bro-
ken. 
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Table 35: Various Errors 

# Description Error Condition Further Information 

182 Temperature Stability not 
reached in specified time. 

Check the "Max Time" value 
in the "Stability Indicator" 
box of the "Temperature 
Controller" window. 
Increase it if necessary or 
set it to 0 to disable this 
function. 

"Max Time" is set too small 
or too high. 
 
Check if your PID Regula-
tion is fine – use our default 
values, it works most of the 
time, even if it is a bit slow. 

183 No package has been re-
ceived within the specified 
Watchdog timeout time. 

- Check the defined Commu-
nication Watchdog 
"Timeout" value in the 
"Communication" window. 
Set it to 0 to disable the 
Watchdog. 

184 Syntax Error in Display For-
mat Argument String 

- See chapter 6.2.1.2 Param-
eter Syntax. 

185 Display Format Argument 
String: Parameter ID not 
available. 
The Error parameter shows 
the parameter ID, which is 
not available. 

- Trying to show values from 
a "Parameter ID" which is 
not available. 
Check your "Display Format 
Argument String" in the 
"Display" window. 

186 Display Format Argument 
String: Parameter Instance 
not available. 
The Error Instance shows 
the parameter Instance 
which is not available. 

- Trying to show values from 
a "Parameter Instance" 
which is not available on 
the controller. 
Check your "Display Format 
Argument String" in the 
"Display" window. 

187 Configuration not sup-
ported 

Some settings are not com-
patible with this device. 

- 

188 Reset required Some essential settings are 
only applied during startup. 
Please reset the device. 

See chapter 2.1.2 Reset the 
TEC Controller. 
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A Change History 

Date of change Version Changed / 
Approved 

Firmware 
Version 

Change / Reason 

30 July 2020 G ML / HS v5.00 • Add Changelog 

• Firmware Updates chapter adapted to FW 
v5.00 

• Front Page: Remove TEC-1161-xA 

• Add TEC-1161 & NTC temperature configura-
tion in chapter 3 

• Incorrect hyperlinks fixed 

30 July 2020 G HS / ML v5.00 • Added matching TEC-Controller Firmware Ver-
sion to footnotes 

• Sentence rephrased and spelling error cor-
rected in chapter 2.3 

23 March 2021 H XF / RS v5.01 • Modified confusing sentence in chapter 7.1.1 
(first bullet point) 

• Modified Display Kit section to feature all dis-
play kits 

30 January 2023 I ML / XF v5.10 • Add: GPIO Function: Ramp 

• Add: Error 185, 186 (Display Format errors) 

• Add: GPIO Function "Fix 0" 

• Bug: Error 109: Text was wrong 

• Add: Hint that Ti can be set to 0s to disable the 
integral term 

• Add: CANopen related information 

• Add: VIN2 related information 

• Add: Error description for TEC-
1162/1163/1166/1167 

• Mod: Object Temperature Source Selection 

27 March 2023 I XF / ML v5.10 • Add: Lookup Table Definitions in chapter 7.1.2 

• Add: Further information column for errors in 
chapter 8.2 

19 July 2023 J ML / XF >v5.10 • Mod: Error numbers 6, 8, 13-15 

• Del: Parameter System Save to Flash Configu-
ration (Save Data to Flash) 
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Date of change Version Changed / 
Approved 

Firmware 
Version 

Change / Reason 

23 September 
2024 

J XF / ML v6.00 • Mod: Various adjustments based on replace-
ment of TEC Service Software with TEC Config-
uration Software starting with firmware v6.00 

• Mod: Generally replaced "Object Measure-
ment" with "HR Input" naming 

• Mod: Generally replaced "Sink Measurement" 
with "LR Input" naming 

• Add: "Software Requirements" chapter 

• Add: "Reset the TEC Controller" chapter 

• Add: "Tooltips" chapter 

• Add: Descriptions of new Operating Modes 

• Add: "Upgrade Firmware from a Version below 
6.00" chapter 

• Add: "Assignment of Measurement Inputs to 
Channels" chapter 

• Add: "Precautions" list in "PID Auto Tuning" 
chapter 

• Mod: "Charting and Data Logging" chapter ad-
justed based on changes in their revised imple-
mentations within the new software 

• Mod: The maximum amount of possible GPIOs 
has increased from 8 to 10 

• Add: "HW Enable Toggle" GPIO function 

• Add: Error numbers 187, 188 

• Fix: Error number 150 had the same error de-
tails as error 151, replaced with correct infor-
mation 

• Del: Error number 110 
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